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Support Services
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up-to-date documentation, visit the STC Documentation Portal at
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This documentation describes the following: SMaRT AFIX installation for Independent
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SMaRT AFIX for Independent
Partners Installation
INnstructions

The SMaRT AFIX for Independent Partners release was requested by the AFIX-11S
Integration Project Consortium and primarily enables Awardee testing to proceed in
states with critical timelines and no integration with IWeb.

The following provides an overview of the process for installing the SMaRT AFIX
application.

Components

SMaRT AFIX is composed of several server components. The following includes their
functions and brief technical descriptions.

Standalone Forecaster (SAF)

SAF is a web application that evaluates patient and vaccination data to produce a
vaccination forecast for that patient. It provides both a user interface and a SOAP web
service. For SMaRT AFIX, only the web service is used.

SAF runs under Apache Tomcat 7.0 and is deployed as a -war file. It utilizes an Oracle
Express Database (XE) to store pre-configured vaccination schedules and
configuration data.

Standalone Forecaster is installed on the Service box.

PostgreSQL
SMaRT AFIX utilizes PostgreSQL 9.4 as a database. An additional Postgres module,
pg_partman, is required. The name of the database is afixdb. It is created via several

-sql scripts. See SMaRT AFIX Database Initialization - Linux or Windows for the
installation instructions.

JasperReports Server (JRS)

JRS is a web application that provides the reports for SMaRT AFIX. These reports are
imported into JRS via the JRS Management Console. See SMaRT AFIX JasperReports
Deployment - Linux or Windows for installation instructions.

Jaspersoft ETL (JETL)

Patient, vaccination, and provider data are batch-loaded into the SMaRT AFIX
database on a nightly basis. Once this data has loaded, it is run through the
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Standalone Forecaster and aggregated into tables that are designed for reporting.
These batch processes are scheduled and executed by Jaspersoft ETL.

SMaRT AFIX Application

The Ul and application server logic are provided via the SMaRT AFIX application. This
is a Node.js application and uses Keycloak for user authentication.

Keycloak

User authentication is provided by Keycloak. It is used by all STC Suite applications
for Single Sign-On (SSO). Each application requires a client within Keycloak. The
client contains references (URLs, ports, etc.) that are specific to each individual

SMaRT AFIX application.

New Application Installations

The following refers to new application installations, not necessarily to upgrade
installations. The instructions differ between Linux and Windows installations as well. If
you are building a new Linux Server, see the Build a Linux (CentOS) Server instructions.

NOTE: The SMaRT AFIX components should be installed in the order listed below.

Component Server Linux Windows
Keycloak Installation Service See either Keycloak Installation Guide for
(SV0O) STC-Hosted Clients or Keycloak Installation
Guide for Self-Hosted Clients.
Standalone Forecaster Service Forecaster Forecaster Installation
(SV0O) Installation Instructions -
Instructions - Linux |Windows
PostgreSQL Server (if not already Database Postgres Database Postgres Database
installed) and Batch Installation - Linux Installation - Windows
(DBB)
SMaRT AFIX Database Database SMaRT AFIX SMaRT AFIX Database
and Batch Database Initialization -
(DBB) Initialization - Linux |Windows
SMaRT AFIX Online Tool Service SMaRT AFIX Online SMaRT AFIX Online
(SV0O) Tool Web Service Tool Web Service
Installation Installation
Instructions - Linux Instructions -
Windows
Jaspersoft ETL Server (if not already |Database Jaspersoft ETL Jaspersoft ETL

installed) (NOTE: Initial ETL loads can

and Batch

Installation_- Linux

Installation_- Windows

take several days; it's recommended |(DBB)

to have them running while other

components are being installed.)

SMaRT AFIX ETL Database SMaRT AFIX SMaRT AFIX
and Batch Jaspersoft ETL Jaspersoft ETL
(DBB) Deployment - Linux |Deployment -
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Component Server Linux Windows
Windows
JasperReports Server (if not already |Application |JasperReports Server |JasperReports Server
installed) (APP) Installation - Linux Installation - Windows
SMaRT AFIX Reports Application |SMaRT AFIX SMaRT AFIX
(APP) JasperReports JasperReports
Deployment - Linux |Deployment -
Windows
Node.js Server (if not already Application |Node.js Installation - [Not supported
installed) (APP) Linux
SMaRT AFIX Application Installation Application |SMaRT AFIX SMaRT AFIX
(APP) Application Application
Installation Installation
Instructions - Linux (Instructions -
Windows
Keycloak Configuration for SMaRT Service Keycloak Configuration for SMaRT AFIX
AFIX (SVC) (Linux and Windows)
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LinuX Instructions

The following instructions are for the Linux operating system.

Build a Linux (CentOs) Server

The instructions below explain how to install CentOS 7 Minimal and configure it. This is a
base configuration suitable for reuse for all servers. An image or snapshot should be
taken, if possible (such as in a cloud or AWS environment), so that these steps do not
need to be performed again. Initially, the server is usually set up with the following:

e CentOS 7 Minimal (64-bit)
e 64-bhit CPU

e 2GB RAM minimum

e 50GB HD minimum

These requirements are only for the initial setup. CPU, RAM, and storage requirements
vary based on server use. Check the STC Suite specifications document prior to installing
additional components on the server.

The instructions below explain how to build a base server from scratch. After following

these steps, an image should be created so that these steps do not need to be performed
again.

Install CentOS 7 Minimal and Configure

CentOS 7 Minimal is installed in order to be able to start from a lean Linux installation.
Packages and software components are added as needed.

1. Disable the SSH login as root - Run the remainder of this steps as root or use
sudo.

2. Edit sshd_config. Vi is used here, but any editor can be used.

sudo vi /etc/ssh/sshd_config

3. On the line that says #PermitRootLogin yes, update it to the following (remember
to remove the #):

PermitRootLogin no

4. Restart the sshd service:

sudo service sshd restart
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5. By default, SELinux is set to be enforced. Change this by running:

sudo setenforce 0O

6. Edit the following file so permissive persists across reboots:

sudo vi /etc/selinux/config

7. Change the line SELINUX=enforcing to the following and save the changes:

SELINUX=permissive

8. Make sure the software is completely up to date:

sudo yum update

9. Finally, install some basic packages:

sudo yum -y install net-tools gcc-c++ openssl-devel make git unzip bzip2
wget vim-enhanced ntp epel-release tmux dos2unix patch

Forecaster Installation Instructions - Linux

The installation of the Standalone Forecaster (SAF) is composed of three major tasks:
install Oracle Express, install the SAF database into Oracle Express, and install the
Forecaster web application into Tomcat. All three components are installed on the Service
machine (SVC).

Install Oracle Express

Perform the following steps as root user.

1. Install the OS libraries and packages on the Linux machine on which XE will be
installed:

yum install bc binutils flex gcc glibc glibc-common glibc-devel libaio
libstdc libXtst make sysstat

2. Create the Oracle user and the Oinstall group:

/usr/sbin/groupadd oinstall
/usr/sbin/groupadd dba

/usr/sbin/useradd -g oinstall -G dba oracle
passwd oracle (Oraclel23)

id oracle
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3. Download the Oracle XE rpm, oracle-xe-11.2.0-1.0.x86_64.rpm.zip, from
http://www.oracle.com/technetwork/database/database-technologies/express-
edition/downloads/index.html and copy it to the server.

4. In the directory where the oracle-xe-11.2.0-1.0.x86_64.rpm.zip file is copied
on the server, run these commands:

unzip -q oracle-xe-11.2.0-1.0.x86_64.rpm.zip
cd Diskl
rpm -i oracle-xe-11.2.0-1.0.x86_64.rpm

5. If the installation is successful, run this command as root. When it asks for an
HTTP port, change it to 7080 so that it doesn't conflict with other installation
applications. Set the initial SYS & SYSTEM password to WELCOME.

/etc/init.d/oracle-xe configure

6. Verify the connection to the database:

cd /uOl/app/oracle/product/11.2.0/xe/bin
-/oracle_env.sh
sqlplus system/<password>0OXE

7. Get the database connection information:

[oracle@ ~]1$ cd /uOl/app/oracle/product/11.2.0/xe/network/admin
[oracle@ ~]$ cat tnsnames.ora

Install the SAF Database

Copy the /SVC/0XE/db/ directory and all of its contents to your server under the Oracle
user's home directory.

It is recommended you change the owner and permissions of the db directory by running
the below commands as root:

chown -R oracle:oinstall db
chown -R 775 db

To install the SAF database, navigate to the

/db/AF1X_CDSI_Install/AFIX _CDS1 _v5.16.9 Install/ directory and execute the
following command as user oracle. Note that your path to bin/oracle/env.sh may
differ.

./u0l/app/oracle/product/11.2.0/xe/bin/oracle_env.sh
sh Install.sh
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Run Database Patches

To update the Forecaster database to the most current patch version, navigate to
/db/Patches/ and run the following:

/patch_v5_ 17 CDSI/forecast.sh

Install the Web Application

Before installing the SMaRT AFIX web application, Java 7 must be installed on the SVC
server and Tomcat 7.0 must also be installed and running on the SVC server.

1. Edit the conf/context.xml file - Add the lines below (between the
<Context></Context> tags) to the CATALINA_HOME/conf/context.xml file. The
added lines should be placed within the <Context></Context> tags in the file.

<Context>
<Resource name="jdbc/com/stc/forecaster"
auth=""Container"
type="javax.sqgl .DataSource™
driverClassName=""oracle.jdbc.OracleDriver"
url="jdbc:oracle:thin:@localhost:1521/XE"
username=""SAFUSER""
password=""SAF"
maxActive=""100"

maxldle="10"
maxWait=""-1"/>
</Context>

2. Navigate to the Application /SVC/SAF directory and execute this command:

$ cp forecaster.war $CATALINA HOME/webapps/forecaster.war

3. Restart Tomcat.

4. Set the number of threads to the number of processor cores available on your
server - Edit $CATALINA_HOME/webapps/forecaster/WEB-INF/spring-ws-
servlet_xml and set the thread count (see the second line of code below):

<bean id=""forecastingEndpointl2"
class=""com.stchome.saf.ws.endpoint.ForecasterServiceEndpointl2"
scope=""prototype'>

<constructor-arg value="1" /><I-- Thread count -->

<constructor-arg value="60" /><!-- Thread pool termination timeout in
seconds-->
</bean>

5. Increase the Tomcat memory usage on your server - Edit
$CATALINA_HOME/bin/setenv.sh and set the thread count (see the second line of
code below):

export CATALINA_OPTS="$CATALINA_OPTS -Xms2048m"
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export CATALINA_OPTS="$CATALINA_OPTS -Xmx2048m"

6. Restart Tomcat.

7. Verify the application is running correctly by navigating to http://[YOUR
SERVER]/forecaster. The Ul displays if the application was successfully installed
and configured.

s I c Forecasting Settings SOAP WSDL Tester

ImmuCast
Forecasting Settings
Vaccine Family Settings Save
Vaccine Family
MENINGOCOCCAL B, OMY @ 4r 4 [ v
DTaP/DT/Td/Tdap [av v v
HIB 4 v T
POLIO av v v
HEP-B 3 DOSE [av v v
MMR 4 v v
VARICELLA 4 v v
MENINGOCOCCAL [4v] v v
HEP-A ar v v
FLU [4r il r
PNEUMO (PCV) g v 2
HEP-B 2 DOSE ar v v
MEASLES v [av] v v
MUMPS v 4v v v
RUBELLA v 4 v v]
PNEUMO (PPSV) [4v] v K|
ROTAVIRUS [a¥ v v
HPV [4r ] x
HERPES ZOSTER 4r 4 v
Vaccine Preferences by Dose to Override ACIP Schedule Recommendations

Postgres Database Installation - Linux

The information below describes how to install the Postgres database on Linux CentOS 7,
as well as how to modify relevant Postgres server configuration settings for SMaRT AFIX.

Install on Linux CentOS 7

Currently, SMaRT AFIX is using CentOS 7 as its Linux distribution. CentOS 7 has Postgres
9.2 included with its default repositories. Postgres 9.4 is required for SMaRT AFIX. The
following steps detail how to upgrade to Postgres 9.4.

Before continuing, it is assumed that you have already followed the Build a Linux
(CentOS) Server instructions.

1. Exclude the postgresqgl package from the CentOS base repositories - Edit
/etc/yum_repos.d/Cent0S-Base. repo and add the exclude lines below to the
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[base] and [updates] sections, then save the changes. Note that this must be
sudo'd to act as root to edit the file:

[base]

name=CentOS-$releasever - Base
mirrorlist=http://mirrorlist.centos.org/?release=%releasever&arch=$basearch&repo=
os&infra=$infra
#baseurl=http://mirror._centos.org/centos/$releasever/os/$basearch/

gpgcheck=1

gpgkey=Ffile:///etc/pki/rpm-gpg/RPM-GPG-KEY-CentOS-7

exclude=postgresqgl*

#released updates

[updates]

name=CentOS-$releasever - Updates
mirrorlist=http://mirrorlist.centos.org/?release=%releasever&arch=$basearch&repo=
updates&infra=$infra
#baseurl=http://mirror.centos.org/centos/$releasever/updates/$basearch/
gpgcheck=1

gpgkey=Ffile:///etc/pki/rpm-gpg/RPM-GPG-KEY-CentOS-7

exclude=postgresqgl*

2. Install the PGDG RPM file:

sudo yum install -y
https://download.postgresqgl .org/pub/repos/yum/9.4/redhat/rhel-7-
x86_64/pgdg-centos94-9_4-2 _noarch.rpm

3. Trigger the packages update:

sudo yum update

4. Install the Postgres 9.4 server/packages:

sudo yum install -y postgresql94-server postgresql94-libs

5. |Initialize the Postgres database:

sudo /Zusr/pgsql-9.4/bin/postgresql94-setup initdb

6. Set Postgres to run as a service and start Postgres:

sudo systemctl enable postgresql-9.4
sudo systemctl start postgresql-9.4

Modify Postgres Server Configuration Settings

Some of the Postgres server configuration settings must be modified.

1. Act as the postgres user to perform admin level changes:

sudo su - postgres
cd 9.4/data/

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide Page 9



2. Add the Postgres /bin/ directory to your path. Edit the ~/.bash_profile and
add the following to the end of the file, then save the file:

PATH=/usr/pgsql-9.4/bin:$PATH
export PATH

3. Run the following to update the bash environment PATH:

source ~/_bash_profile

4. Edit postgres.conf with your favorite editor and add the following line right after
# - Connection Settings -, then save the file:

listen_addresses = "**

5. Edit the pg_hba.conf file to allow connections from other STC
servers/applications and secure the connection using md5 instead of clear text
passwords. Change the following line:

host all all 127.0.0.1/32 md5

to something like the following, which will enforce md5-encrypted password
communication. Let's assume your internal sub-net falls under 192.168.x.x, which
would update the line to:

host all all 192.168.0.0/16 md5

6. Save the changes. If you are technical and familiar enough with CIDR notation,
you can further customize and restrict connection access as needed.

7. Trigger Postgres to reload with the new configuration changes by running:

pg_ctl restart

8. Complete the installation by initializing the database (see SMaRT AFIX Database
Initialization - Linux).

Add Fuzzy Search Module to Postgres DB

In independent deployments of SMaRT AFIX, provider data is pulled from the SMaRT
AFIX Postgres database. This requires that an additional plugin be added to the database
to enable fuzzy searching.

1. Log in to the database server (dbb) as a root user:

sudo su - root

2. Install the contrib package:
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3.

yum install postgresqgl-contrib

Enter "Y" when prompted.

4. Switch to postgres user:

5.

sudo su - postgres

Log in to afixdb and create an extension for the fuzzy search:

psql -d afixdb
afixdb=# create extension fuzzystrmatch;
CREATE EXTENSION

SMaRT AFIX Database Initialization - Linux

The information below describes how to initialize the database for the first time, how to
upgrade/migrate an existing database, and how to set up daily jobs.

Prerequisite Tasks

Perform the following tasks before initializing the database:

1.
2.

Confirm that PostgreSQL has been installed.

Download the release distribution zip file from /DBB/POSTGRES and extract the
database scripts for the database server.

As a root user, give read, write, and execute permissions on the flyway command
- Navigate to the /DBB/POSTGRES directory and execute this command:

cd /DBB/POSTGRES/
chmod 755 flyway

As a root user, install the dos2unix package:

yum install dos2unix

As a POSTGRES user, run the dos2unix command for the flyway file to make it
compatible for Linux - Navigate to the /DBB/POSTGRES directory and execute this
command:

cd /DBB/POSTGRES/
dos2unix Flyway

State-specific eligibility: If your state uses one or more state-specific codes for
VFC eligibility, you will need to make a modification to the
/DBB/POSTGRES/sql/0LAP/OLAP_V1 0 _2 R1 Afix_OLAP_Initial_Data.sql file.
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Add the state-specific codes to the DIM_VFC_ELIGIBLE section as noted below. Be
sure to increment the vfc_eligible_key value for each state-specific code you add.
State-specific codes should be added exactly as they appear in your system
database.

. --DB_script for DIM_VFC_ELIGIBLE----
INSERT INTO olap.dim_vfc_eligible(vfc_eligible_key,
vfc_eligible_code, created_ts)
VALUES (1, “Not VFC Eligible-Underinsured®, current_timestamp),
(2, "VFC Eligible - State Specific Eligiblity",
current_timestamp),
(3, "Local-Specific Eligiblity", current_timestamp),
(4, “Not VFC Eligible®, current_timestamp),
(5, "American Indian/Alaska Native®, current_timestamp),
(6, "Uninsured”, current_timestamp),
(7, "Federally Qualified Health Center patient”,
current_timestamp),
(8, "Medicaid®, current_timestamp),
--Add State Codes here----
(9, "State Specific Code", current_timestamp),
(-1, "Unknown®, current_timestamp);

Initialize a New Database (for the First Time Only)

If this is the first time you are initializing the database, follow the steps below.
Otherwise, see the Upgrade/Migrate an Existing Database instructions.

1. Act as the postgres user:
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sudo su - postgres

Prepare the tablespace by creating the directories that will be used by afixdb:

mkdir -p /var/lib/pgsql/9.4/afixdb
mkdir -p /var/lib/pgsql/9.4/afixdb/data
mkdir -p /var/lib/pgsql/9.4/afixdb/olapdata

Add postgres to your path:

export PATH=$PATH:/usr/pgsql-9.4/bin

Create the afixdb by navigating to the /DBB/POSTGRES directory and executing
this command:

cd /DBB/POSTGRES/
psql -a -f setup_database.sql

Create the database users and roles:

psql -d afixdb -a -f setup_objects.sql
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6. Create the APP configuration schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb
sglMigrationPrefix=APP_V -user=afix migrate

7. Create the ODS schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqglMigrationPrefix=0DS_V -user=afix migrate

8. Create the OLAP schema:

- /flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqglMigrationPrefix=0LAP_V -user=afix migrate

Upgrade/Migrate an Existing Database

-schemas=app -

-schemas=ods -

-schemas=olap -

If this is not the first time you are initializing the database, follow the steps below.
Otherwise, see the Initialize a New Database (for the First Time Only) instructions.

1. Act as the postgres user:

sudo su - postgres

2. Migrate the APP configuration schema:

- /flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqgIMigrationPrefix=APP_V -user=afix migrate

3. Migrate the ODS schema:

- /flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqglIMigrationPrefix=0DS_V -user=afix migrate

4. Migrate the OLAP schema:

./flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqglMigrationPrefix=0LAP_V -user=afix repair

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb
sqlMigrationPrefix=0LAP_V -user=afix migrate

Set Up a Daily Job / Drop Partition

1. Copy partition.sqgl from the /DBB/POSTGRES directory to
/var/lib/pgsql/9.4/afixdb:

cp partition.sql /var/lib/pgsql/9.4/afixdb
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-schemas=olap -

-schemas=olap -

Page 13



2. Add a crontab entry to run the partition script daily at 1:00 a.m. to create future
partitions and drop old partitions:

[postgres@interop-qa0-dbb ~]$ crontab -e

#Add below 2 entries and save it (Esc + Shift + - + wq + Enter)
LOGFILE_AFIXDB=/var/lib/pgsql/9.4/afixdb/partition.log

01***echo "——————-————— - " >> $LOGFILE_AFIXDB ;
date >> $LOGFILE_AFIXDB ; psgl -d afixdb -U postgres -f
/var/lib/pgsql/9.4/afixdb/partition.sql &&gt;> $LOGFILE_AFIXDB

SMaRT AFIX Online Tool Web Service
Installation - Linux

The SMaRT AFIX Online Tool web service is used by the SMaRT AFIX application to
generate an XML file to be uploaded to the CDC's AFIX online tool application. The web
service is a simple web application that is installed alongside the Stand Alone Forecaster
on the Service machine (SVC).

Prerequisites

The Postgres database is installed and configured.
The Postgres password for the SMaRT AFIX database is known.
The Tomcat instance is installed on the SVC server.

All necessary ports are open across all firewalls.

a > b NPk

The release distribution file for the SMaRT AFIX Online Tool web service is
extracted from /SVC/ONLINE_TOOL/aFix.export.ws.war and copied to your local
drive.

Installation Steps

1. Copy the afix.export.ws.war file to your Tomcat webapps folder
($CATALINA_HOME is your Tomcat installation directory):

$ cp afix.export.ws.war $CATALINA_HOME/webapps/afix.export.ws.war

2. Restart Tomcat.

3. Update the application properties to point to the proper Postgres database. Make
sure the username and password are correct.

4. Edit the $CATALINA_ HOME/webapps/afix.export.ws/WEB-INF/app.properties
file:

driverClassName=org.postgresql .Driver
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url=jdbc:postgresql://127.0.0.1:5432/afixdb
username=afixUser
password=afixPassword

5. Restart Tomcat.

6. Verify the installation with this command. Note that you may need to adjust the
port from 8080, depending on your Tomcat configuration.

curl -XGET
"http://1ocalhost:8080/afix.export.ws/api/vl/sitevisit/?org_id=
0&fac_id=0&cohort=All" -H "API-KEY: 123456" -H "accept:application/xml"

7. Verify that you have the following result:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AFIXExport xsi:schemaLocation="http://www.cdc.gov/afix/online-
tool/1.1/exportSchema CDC_AFIX_Export.xsd"
xmIns="http://www.cdc.gov/afix/online-tool/1.1/exportSchema"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<Header>

<AwardeeName>No Provider Found</AwardeeName>

</Header>

</AFIXExport>

Jaspersoft ETL Installation - Linux

Follow these instructions to install Jaspersoft ETL, Apache Web Server, and Subversion,
and to configure the administration console. This installation only needs to occur once.

Prerequisites

1. Java JDK 8 (1.8.91) has been installed.

2. The environment variables JAVA _HOME, JDK_HOME, and PATH have been set.
Example:

export JAVA HOME=/usr/lib/jvm/jdkl1.8 91
export JDK_HOME=/usr/lib/jvm/jdk1.8 91
export PATH=$JAVA HOME/bin:$PATH
export PATH=$JDK_HOME/bin:$PATH

3. Copy the components from the distribution /Server Components/ETL directory
into your local directory. These files include:
e license.txt

e TIBCOJaspersoft-JETL-Installer-20150908...zip

o etl.zip
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Install Jaspersoft ETL

1. Download the Jaspersoft ETL installer zip file:

Server Components/ETL/TIBCOJaspersoft-JETL-Installer-20150908 1633-
V6.0.1-installer.zip

2. Place the installer into the installation directory:

/opt/TIBCOJaspersoft-JETL-Instal ler-20150908_1633-V6.0.1-installer.zip

3. Navigate to the installation directory:

$ cd /opt

4. Install the Unzip utility if it is not already present:

$ sudo yum install zip unzip -y

5. Unzip the installer:

$ sudo unzip TIBCOJaspersoft-JETL-Installer-20150908 1633-V6.0.1-
installer.zip

6. Set the execute permission on the installer:

$ sudo chmod +x TIBCOJaspersoft-JETL-Installer-20150908_1633-V6.0.1-
linux64-installer.run

7. Execute the installer:

$ sudo ./TIBCOJaspersoft-JETL-Installer-20150908 1633-V6.0.1-11nux64-
installer.run

8. Follow the prompts to accept the license agreement.

9. Follow the prompts to specify the installation folder. Specify the
/opt/TIBCOJaspersoft-6.0.1 directory.

10. Follow the prompts to select the install style of item 1 (Easy).
11. Follow the prompts to select the install type of item 1 (Server).

12. Follow the prompts to select the license file (provide the location of the license
file).

13. Wait until the installation completes.

Install the Apache Web Server and Subversion

1. Install the Apache Web Server:
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$ sudo yum install httpd

Start the Apache Web Server:

$ sudo service httpd restart

Configure the Apache Web Server to start on boot:

$ sudo chkconfig httpd on

Install SVN/Subversion:

$ sudo yum install httpd mod_dav_svn subversion

Configure an SVN repository for all of the Talend projects:

sudo mkdir /var/www/svn

sudo svnadmin create /var/www/svn/repo

sudo touch /var/www/svn/passwdFile

sudo htpasswd -m /var/www/svn/passwdFile tisadmin
sudo chown -R apache.apache /var/www/svn

LR ]

Configure an SVN repository for the Talend library:

$ sudo svnadmin create /var/www/svn/talendlibrary
$ sudo chown -R apache.apache /var/www/svn

Configure the settings:

# sudo vim /etc/httpd/conf.d/subversion.conf
<Location /repo>

DAV svn

SVNPath /var/www/svn/repo

Require valid-user

AuthType Basic

AuthName *‘Subversion™

AuthUserFile /var/www/svn/passwdFile
</Location>

<Location /talendlibrary>

DAV svn

SVNPath /var/www/svn/talendlibrary
Require valid-user

AuthType Basic

AuthName *‘Subversion®

AuthUserFile /var/www/svn/passwdFile
</Location>

8. Restart the Apache Web Server:

$ sudo systemctl restart httpd

9. Special instructions for AWS instances: If ETL and SVN are configured on the
same AWS instance, execute this command. ServerName is the name (IP

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide
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address) of the AWS server. Example: iptables -t nat -A OUTPUT -p all -d

52.42.200.159 -j DNAT --to-destination 127.0.0.1

Syntax: iptables -t nat -A OUTPUT -p all -d ServerName -j DNAT --to-

destination 127.0.0.1

Start/Stop Jaspersoft ETL Services

The following are the instructions to start and/or stop Jaspersoft ETL services. These

steps are not mandatory on a first-time installation because the services will be running

by default.

Start/Stop Jaspersoft ETL Admin Console

Command to stop the service:

$ cd /Zopt/TIBCOJaspersoft-6.0.1/jac
$ sudo ./stop_tac.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jac
$ sudo ./start_tac.sh

Start/Stop Jaspersoft ETL Command Line

Command to stop the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/cmdline
$ sudo ./stop_cmdline.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/cmdline
$ sudo ./start_cmdline.sh

Start/Stop Jaspersoft ETL Job Server

Command to stop the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jobserver
$ sudo ./stop_jobserver.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jobserver
$ sudo ./start_jobserver.sh
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Configure the Admin Console

These steps are used one time only. They should be completed during the server
installation.

1. Navigate to http://[host name]:8080/0rg.jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Navigate to Configuration on the left menu and update the SVN and library
information.
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Navigate to User Settings on the left menu and update the username (if

needed), SVN, and library information.

-]
x]
=

admin
Fassword change password
ogin visa

-]
=

Ty e Data Integratior -

Conmecctions stats

To the Administration Center

Click on Role and select all of the roles.

Roles Selection X

Role

Administrator

Operation manager

Designer

«" Validate

Navigate to Project settings from the left menu and add a new project by

clicking the Add button.

Create two projects. Name the first one InteropProject, select the Active

option, enter Interop ETL as the description and admin admin as the Author,

and select SVN as the storage, then save it.
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Project

Label:

Active:

Reference:

Description: Interop ETL
Author:

Storage:

Advanced sattings

e

7. Name the second project Interop_Reference, select both the Active and
Reference options, do not enter a description, use admin admin as the Author,
and select SVN as the storage again, then save it.

Project
Label:
Active:
Reference:
Description:
Author:
Storage:

Advanced settings

= e T e T e

8. Navigate to Project authorization from the left menu. Click on each of the
newly created projects and assign read/write permissions to the user.
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9.

10.

11.

12.

“-» PROJECT AUTHORIZATIONS

for the Project: InteropProject
Autharizations by Project
: Project: InteropProject

Lastname Firstna.. Active

Create the following directories and files in the server:

sudo mkdir /opt/TIBCOJaspersoft-6.
sudo mkdir /opt/TIBCOJaspersoft-6.
sudo mkdir /opt/TIBCOJaspersoft-6.0.1/deploy/executionlLogs
sudo mkdir /opt/TIBCOJaspersoft-6.0.1/cmdline/exports

0.1/deploy
0
0
0
sudo mkdir /opt/TIBCOJaspersoft-6.0.1/Audit
0
0
0

-1/deploy/generatedJobs

sudo mkdir /opt/TIBCOJaspersoft-6.0.1/Audit/reports
sudo mkdir /opt/TIBCOJaspersoft-6.0.1/joblogs
sudo touch /opt/TIBCOJaspersoft-6.0.1/joblogs/log

In Primary Command Line configuration, set the path for the Job generation folder

to /opt/TIBCOJaspersoft-6.0.1/cmdline/exports

b . .

Haost: localhost @
Port: 8002 ©
@ Validity of path cannot be checked

Job generation folder: lopt/TIBCOJaspersoft-6.0.1/cmdline/exports

User compaonent path: @ validity of path cannot be checked

Version 6.0.1.20150908_1633 ®

In Job Conductor configuration, set the path for the Generated jobs folder to

/opt/TIBCOJaspersoft-6.0.1/deploy/generatedJobs and the path to the Tasks

logs folder to Zopt/TIBCOJaspersof-6.0.1/deploy/executionLogs

| Job Conducter (7 Parameters @

Ienerated jobs folder: lopt/TIBCOJaspersoft-6.0.1/deploy/generated Jobs (]

Fasks logs folder: fopt/TIBCOJaspersoft-6.0.1/deploy/executionlogs @

Fumber of executions log: 1000 @
fMaximum age of log file(d): 0 (@]
fMaximum number of generated 3 @

obs:

Maximum age of generated job(d): |0 (]

Duartz serviet @ initialized

In Logging configuration, set the Technical log file path to
/opt/TIBCOJaspersoft-6.0.1/joblogs/log

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide

Page 22



- Logging (4 Parameters / 1 errors L]

Technical log file path: opt/TIBCOJaspersoft-6.0.1/joblogs/log

Technical log threshold: WARN

Business log file path:

(O <]

13. In Audit configuration, set the Reports stored path to Zopt/TIBCOJaspersoft-

6.0.1/Audit/reports

= Audit (6 Parameters @

Url: jdbc:h2:/opt/TIBCOJaspersoft-6.0.1/jac/apache-tomee
User: tisadmin
Password:  |eessees
Driver: org.h2.Driver v
Web Console http://52.33.215.54:8080/org. jaspersoft.administra

tor/h2console
Reports stored path: opt/TIBCO aspersoft-6.0.1/Audit/reports

e
e
©
©
e

@

14. Navigate to Servers page from the menu and create a new execution sever with

the following settings:
e Label: Name of the job server
e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000
e File transfer port: 8001
e Monitoring port: 8888
e Active: Select this option (enable)
e Username: the admin username for the ETL

e Password: the password for the admin ETL user
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15.
16.

17.

18.

Execution server

Label: qab-etl
Description:

Host: 10.0.5.137
Time zone:

[

Command port: | 8000

File transfer 8001
port:

Monitoring port: | B&88
Timeout on 120

unknown state

\5):
Username: admin@stchome.com
Password:

UJse S5L:

Active:

Jaspersoft Runtime

Log in via SSH to the Unix server using the ETL server owner.

Copy the etl .zip file (from /DBB/ETL) to a location convenient for you on the

ETL Jaspersoft server to unzip the file, such as a home directory.

Unzip the etl.zip file to the server in the root directory (Unix), which creates a

directory structure similar to this:
o Jetl
e /etl/data
e /etl/archive

Set up SMTP in Configuration only if the user needs an email notification on
failure of jobs. Use the following settings:

e Use SMTP > False

e Host: company's email SMTP server
e Port: host's port number

e Username: host's username

e Password: user's password
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B4 su7P (6 Parameters / 3 errors @

Use SMTFP: true v
Host:

Port:

Require S5L: false

Username: user@domain.com

Password:  |eeesesees

SMaRT AFIX Jaspersoft ETL Deployment -
Linux

The following outlines how to import (migrate) Jaspersoft ETL for SMaRT AFIX.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured
¢ Retrieve the passwords for the SMaRT AFIX database (afixdb)
¢ Retrieve the Jaspersoft ETL admin username and password

e Confirm that port 8080 is open across all firewalls

e Confirm that all of the steps in the Admin Console configuration are completed on
a first-time installation

e Copy these components from /DBB/ETL into your local directory:

APIl_Vaildation_Sequential_Execution_0.1
etl
Forecaster_Sequential_Execution_0.1
ODS_Sequential_Execution_0.1
OLAP_Sequential_Execution_0.1
AFIX_Assessment_Benchmark 0.1
e UserApi_Sequential_Execution_0.1
e Identify whether the installation is an upgrade from prior versions or a fresh
installation from scratch.

New Installation Instructions (for the First Time Only)

If this is the first time you deploying Jaspersoft ETL, follow the steps below. Otherwise,
see the Upgrade Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.
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Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg.jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Navigate to Project settings from the left menu and add a new project by
clicking the Add button.

3. Name the new project AFIX_ETL. Select the Active option, enter admin admin
as the Author, and select SVN as the Storage.

Project
Label:
Active:
Reference:
Description:
Author:
Storage:

Advanced settings

4. Navigate to Project authorization from the left menu. Click on the newly
created project and assign read/write permission to the user.

User Authorizations for the Project: AFIX_ETL
Type Login Last name Firstna.. Active Right

W admin@stchome.com admin admin [~] {-:

5. Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: AFIX_jobServer

e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000

e File transfer port: 8001

e Monitoring port: 8888

e Active: Select this option (enable)

e Username: the admin username for the ETL

e Password: the password for the admin ETL user
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Execution server

Label: qaf-etl
Description:

Host: 10.0.5.137
Time zone:

<4

Command port: |&000

File transfer E001
port:

Monitoring port: |2ag8
Timeout on 120

unknown state

(5):

Username: admin@stchome.com
Password:

Use S5L:

Active:

Jaspersoft Runtime

6. Log in via SSH to the Unix server using the ETL server owner.

7. Copy the etl.zip file (from /DBB/ETL) to a location convenient for you on the
ETL Jaspersoft server to unzip the file, such as a home directory.

8. Unzip the etl .zip file to the server in the root directory (Unix), which creates a
directory structure similar to this:

o /etl/afix

o /etl/afix/api

e /etl/afix/archive
e /etl/afix/bulkload
e /etl/afix/dataout
o /etl/afix/input

o /etl/afix/rejects

o /etl/afix/tmp

e /etl/afix/validation

Deplovy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.
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2. Copy the following files from the installation files to a convenient location to
deploy:

e UserApi_Sequential_Execution.zip
e APl _Validation_Sequential _Execution.zip
e ODS_Sequential_Execution.zip
e Forecaster_Sequential_Execution_0.1.zip
e OLAP_Sequential_Execution.zip
e AFIX_ Assesment_Benchmark.zip

3. Navigate to the Job Conductor page.

4. Select Add > Normal Task and add the following: Label = User APl Execution;
Description = User APl Execution.

5. Click Import Generated Jobs and select the
UserApi_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

6. Click Save.
7. Navigate to the task AFIX IWeb API Validation.

8. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Validation; Description = AFIX IWEB API Validation.

9. Click Import Generated Jobs and select the
AP1_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

10. Click Save.

11. Select Add = Normal Task and add the following: Label = AFIX Stage 2 ODS
Load; Description = AFIX Stage 2 ODS Load.

12. Click Import Generated Jobs and select the
0ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

13. Click Save.

14. Select Add > Normal Task and add the following: Label = AFIX Forecast
Execution; Description = AFIX Forecast Execution.

15. Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.
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16.
17.

18.

19.
20.

21.

22.
23.

24.
25.
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Click Save.

Select Add > Normal Task and add the following: Label = AFIX OLAP Execution;
Description = AFIX OLAP Execution.

Click Import Generated Jobs and select the

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following: Label = AFIX Assessment
Benchmark; Description = AFIX Assessment Benchmark.

Click Import Generated Jobs and select the

AFIX_Assessment_Benchmark.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To
e Email_SMTP_Host
e Email_SMTP_Port
e AFIX_Email_Notification
e Email_Active
e Email_UserName
e Email_Password
e Web service related parameters (Forecaster):
e SOAP_ACTION
e ENDPOINT
e Database-related parameters:
e AFIX DB - Login, Password, Port, Database, and Server
e Source_DB_Context - Login, Password, Port, Database, and Server
Save when finished.

Initial load instructions:
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¢ Run the AssessmentBenchmark task

e Go to the task IWeb API Validation and add a file trigger with the
following values: Label = TriggerValidationAPI, Folder Path = /etl/afix/api,
File Mask = START_ETL_RUN.tkn , Pollint(s) = 200

e Go to the task AFIX Stage 2 ODS Load and add a file trigger with these
values: Label = TriggerODSLoad, Folder Path = /etl/afix/dataout, File Mask
= API_VALIDATION_Complete.tkn, Pollint(s) = 200

Add file trigger

e Go to the task AFIX Forecast Execution and add a file trigger with the
following values: Label = TriggerForecast, Folder Path = /etl/afix/dataout,
File Mask = API_LOADS_TO_ODS_ Complete.tkn, Pollint(s) = 200. Add the
JVM parameters -Xms1024M and -Xmx15690M

Rl File Erigger

e Go to the task AFIX OLAP Execution and add a file trigger with the
following values: Label = TriggerOLAP, Folder Path = /etl/afix/dataout, File
Mask = Forecast _Loads_Complete.tkn, Pollint(s) = 200. Add the JVM
parameters -Xms1024M and Xmx15690M

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide Page 30



Add file trigger
Label: TriggerOLAP

Description: TriggerOLAP

Pause trigger on
error:

Go to the task UserApi Sequential Execution and add a file trigger with

the following values: Label = TriggeruserAPIl, Folder Path =

/etl/afix/dataout, File Mask = OLAP Complete.tkn, Pollint(s) = 200. After

that, run the task UserApi Sequential Execution.

Add file trigger
Label:
Pescription:
Pollint (s):

Folder path:

26. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Go to the AFIX IWeb APl Execution
task and add the Cron trigger Trigger_IWeb_API. Enter the following values and

save:

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide
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Years: leave blank
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Asdldd Crom trigger

8 orencron

27. Turn on the notify/email feature. Important Note: SMTP needs to be configured
beforehand.

o Select Notifications from the left menu
e Click Add

e Select the Tasks category

e Select On task failed

e Select Enabled

e Select Recipients to specify the user's email. It is better to create an
email group as a recipient so that notifications are sent to multiple people

e Select AFIX ETL Workflow
If the upgrade needs to be aborted for any reason, import the previously created backup.

Alternatively, redeploy the previous version of the content.

Upgrade Instructions

If this is not the first time you are deploying Jaspersoft ETL (i.e., it was deployed earlier),
follow the steps below. Otherwise, see the New Installation Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Log in via SSH to the Unix server using the ETL server owner.

3. Copy the etl.zip file (located at /DBB/ETL) to the Jaspersoft ETL server. Use a
location convenient for you to unzip the file, such as a home directory.

4. Unzip the etl.zip file to the server in the Unix root directory (Unix), which adds
the following files that were created as part of this release:
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o /etl/afix

o /etl/afix/api

e /etl/afix/archive
e /etl/afix/bulkload
e /etl/afix/dataout
o /etl/afix/input

o /etl/afix/rejects

o /etl/afix/tmp

e /etl/afix/validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e UserApi_Sequential _Execution.zip

e APl _Validation_Sequential_Execution.zip
e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip
e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

3. Navigate to the Job Conductor page.

4. Select Add = Normal Task and add the following: Label = AFIX Assessment

Benchmark; Description = AFIX Assessment Benchmark.

5. Click Import Generated Jobs and select the AFI1X_Assessment_Benchmark.zip
file downloaded as part of the prerequisites. Add the following: Execution server

= AFIX_JobServer; On Unavailable JobServer = Recover Task.
6. Click Save.
7. Navigate to the task AFIX IWeb API Validation.

8. Click Import Generated Jobs and select the
UserApi_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

9. Click Save.
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10. Navigate to the task AFIX IWeb API Validation.

11. Click Import Generated Jobs and select the
API_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

12. Click Save.
13. Navigate to the task AFIX Stage 2 ODS Load.

14. Click Import Generated Jobs and select the
ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

15. Click Save.
16. Navigate to the task AFIX Forecast Execution.

17. Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

18. Click Save.
19. Navigate to the task AFI1X OLAP Execution.

20. Click Import Generated Jobs and select the
OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

21. Click Save.

22. For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To

e Email_SMTP_Host

e Email_SMTP_Port

e AFIX_Email_Notification
e Email_Active

e Email_UserName

e Email_Password
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e Custom Date: Set to the current date +1. For example, if the current date
is 2017-03-06, the context value should be set to 2017-03-07.

23. Save when finished.

24. Initial load instructions: Go to the task AFIX IWeb APl Execution. Run the task
and wait to see if the job executes without any issues. Once it has made
progress, make sure each of these tasks is triggered and completes:

¢ |IWeb API Validation
e State 2 ODS Load

e Forecast Execution
e OLAP Execution

25. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Resume the CRON trigger
Trigger_IWeb_API. Go to the task OLAP_Sequential_Execution and change the
context parameter custom date to the original value in
OLAP_Sequential_Execution and save.

If the upgrade needs to be aborted for any reason, import the previously created backup.
Alternatively, redeploy the previous version of the content.

JasperReports Server Installation - Linux

The following instructions explain how to install the JasperReports Server.

Prerequisite

Download all of the JasperReports Server contents from the distribution site. The JRS
folder contains the following files:

¢ applicationContext-externalAuth-oAuth

e applicationContext-security

e applicationContext-security-web

¢ InstallCert$SavingTrustManager.class

e InstallCert.class

e jJasperreports-server-6.2.1-linux-x64-installer.exe
e jasperserver.license

e LatoFont

e stc-jaspersoft-oauth-0.0.1-SNAPSHOT
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Installation Steps

1. Download the JasperReports Server installer from the release distribution:

/Server Components/JRS/jasperreports-server-6.2._1-1inux-x64-
installer._run

2. Place the JasperReports Server installer into the target directory:

/opt/jasperreports-server-6.2.1-linux-x64-installer.run

3. Navigate to the target directory:

$ cd /opt

4. Set the execute permissions for the JasperReports Server installer:

$ sudo chmod u+x ./jasperreports-server-6.2._.1-linux-x64-installer.run

5. Run the installer:

$ sudo ./jasperreports-server-6.2.1-linux-x64-installer.run

6. Follow the prompts to accept the license agreement.

7. Follow the prompts to select an install option. Select option 1 - Install All
Components and Samples.

8. Follow the prompts to specify the installation folder. Specify the following
directory:

/opt/jasperreports-server-6.2.1

9. When the installer completes, start the JasperReports Server (see Start/Stop the
JasperReports Server below).

10. Before continuing, you need to update a configuration file on the JasperReports
Server. Navigate to:

cd /opt/jasperreports-server-6.2.1/apache-tomcat/webapps/jasperserver-
pro/WEB-INF/classes/

11. Open jasperreports._properties for editing and add the following under the
section marked # Highcharts static export properties:

com. jaspersoft. jasperreports._highcharts.function._properties.al lowed=true
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12. Save the file and restart the JasperReports Server (see Start/Stop the
JasperReports Server below).

13. Validate the installation by logging in to the JasperReports Server console. Use
your browser to access the server. Replace <hostname> below with the name or
IP address of the server:

http://<hostname>:8080/jasperserver-pro

14. Log in with the user ID of superuser and the default password of superuser.
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Update the License File

Follow these steps to update the license file for the JasperReports server:

1. Copy the license file (Jasperserver.license) from the distribution site and move
it to your home directory using FTP or WinSCP.

2. Replace the license file in the JasperReports installation directory
(/opt/jasperreports-server-6.2.1/) with the license file from the above step,
overwriting the existing jasperserver.license file.

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).
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Increase the JasperReports Session Timeout Period

By default, the JasperReports timeout period is set to 20 minutes. However, the timeout
period should be reset to 32 minutes in order to match with Keycloak.

1. Open web.xml from the path /opt/jasperreports-server-6.2.1/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/web.xml

Search for the property <session-timeout> under <session-config> and update

the value to 32. After this, the property and value should be similar to the image
below:

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Start/Stop the JasperReports Server
Use these commands to start and stop the JasperReports server.

Start

$ cd /opt/jasperreports-server-6.2.1
$ ./ctlscript.sh start

Stop

$ cd /opt/jasperreports-server-6.2.1
$ ./ctlscript.sh stop
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JasperReports Configuration with Keycloak

A few configuration changes need to be made in order for JasperReports to be used with

Keycloak.

Prerequisite

Keycloak must be installed and set up, if the SSO-enabled version of IWeb and VOMS is

being used.

JasperReports Server Modifications

1. Edit the following values in the applicationContext-externalAuth-oAuth.xml

file:
Key

[KEYCLOAK_URL]

XML Tag Name(s) to
Update
<authorization_location>
<token_location>
<userdetails_location>
<logoutUrl>

Value

URL of the Keycloak server.
Example: https://sso-dev.stchome.com/

[KEYCLOAK_REALM]

<authorization_location>
<token_location>
<userdetails_location>
<logoutUrl>

Keycloak realm that the client belongs to.
This value needs to be changed, along with
<keycloak_URL>.

In this example, the realm name is Dev-
Integration: https://sso-
dev.stchome.com/auth/realms/Dev-
Integration

[JASPERSERVER_URL]

<property
name="redirecturl">
<property
name="logoutUrl">

URL of the Jasper server. Example:
http://<server_name>:8080/jasperserve
r-pro/oauth

[CLIENT_ID]

<property
name="client_id">

Client ID as set on Keycloak. Example:

<property name="client_id">
<value>jasper-aws-dev</value>

[CLIENT_SECRET]

<property
name="clientsecret">

<property

name="userdetails_secret"

>

Credentials secret key generated by
Keycloak.

State ID

<property name="state">

This is the global setting used to populate
the STATE_ID attribute in Jaspersoft.
Example:

<bean id="oAuthUserDetailsService"
class="com.jaspersoft.jasperserver.ps.OAut
h.OAuthUserDetailsServicelmpl">
<property name="state">
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Key XML Tag Name(s) to  Value
Update
<value>WA</value>
</property=>
</bean>
Jaspersoft Roles <bean All the Jaspersoft Roles are configured inside

id="mtExternalUserSetupPr
ocessor"
class="com.jaspersoft.jasp
erserver.multipleTenancy.s
ecurity.externalAuth.proces
sors.MTExternalUserSetupP
rocessor"
parent="abstractExternalPr
ocessor''>

<property
name="organizationRoleMa
p'>

<map>

<!I-- Example of mapping
customer roles to JRS roles
-

<entry>

<key=>
<value=>ROLE_ADMIN_EXT
ERNAL_ORGANIZATION</v
alue>

</key=>

<value>ROLE_ADMINISTR
ATOR</value>
</entry>

</map>

this tag. If any new Jaspersoft Roles are
needed, they must be configured here. In
the <entry> tag, the key value should
match with the client role defined at the
Keycloak end.

Currently, the following roles are configured:

1. Administrator
2. Superuser

3. User Role

2. Copy the applicationContext-externalAuth-oAuth.xml file (edited in Step 1)
to <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB- INF.

3. Copy stc-jaspersoft-oauth-1.0.0.jar (available in the JRS distribution folder) to
<JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/1ib.

4. Create and save a backup of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-

security.xml file.

5. In <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-
INF/applicationContext-security.xml, replace the access value for the

method

com. jaspersoft. jasperserver.api.metadata.user.service.ProfileAttribut
eService.putProfileAttribute with ROLE_USER.

6. Save a backup copy of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-
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security.xml file again and replace the constructor-arg value for
org.springframework.security.web.authentication.LoginUrlAuthenticationEntryPoin
t with Zoauth.

7. Add the SSL certificate used by Keycloak to the Java installation that Jaspersoft is
using. (By default, Java only knows about a small number of root certificates.) To
do this, follow these steps:

a. Copy InstallCert$SavingTrustManager.class and InstallCert.class
(both available in the STC Suite Distribution/Server Components/JRS
directory) to the <JASPERSERVER_DIR>/java/bin directory.

b. NOTE for sso-dev.stchome.com: This is only for Dev SSO SSL certificate
installation. This URL changes based on your server hostname of the
Keycloak/SSO server.

c. Go to the <JASPERSERVER_DIR>/java/bin directory and execute these
commands:

sudo ./java InstallCert sso-dev.stchome.com

sudo ./keytool -exportcert -alias sso-dev.stchome.com-1 -keystore
Jssecacerts -storepass changeit -file sso-dev.stchome.com.cer
sudo ./keytool -importcert -alias sso-dev.stchome.com -keystore
-./lib/security/cacerts -storepass changeit -file sso-
dev.stchome.com.cer

8. Make database changes with the following commands. Jaspersoft stores all of its
metadata in the Postgres database. All of the user-based profile attributes are
stored in the jiprofileattribute table in Jaspersoft. By default, user attributes
support a character size of 200. In Step E below, the data type size is changed
from 200 to 1,000.

a. Navigate to the <Jasper Installation Directory>/postgres directory.

b. Run this command: sudo bin/psgl -U postgres -W (the password is
postgres).

c. Now you should see at the prompt: postgres=#

d. Enter this command to connect to the Jasperserver database in Postgres: \c
Jasperserver; (the password is postgres).

e. Execute this SQL alter script: ALTER TABLE jiprofileattribute ALTER
COLUMN attrvalue TYPE character varying(100000);

9. Restart the Jasper server and navigate to JasperUrl/oauth (see example). You

should now be redirected to Keycloak to log in. Example:
http://52.10.228.158:8080/jasperserver-pro/oauth
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Steps to Debug Issues Related to
Keycloak/JasperReports Server Integration

If there are any issues with integrating Keycloak with Jasper, follow these suggestions
below.

Check the applicationContext-externalAuth-oAuth.xml File

Make sure that applicationContext-externalAuth-oAuth.xml is configured with the
correct Keycloak and Jasper server parameters and with the correct client_secret.

Keycloak Mappers
Make sure that the Jasper client has the below mappers mapped correctly in Keycloak,

and check if the Org/fac List mapper contains the correct parameters. (Note that your
API-KEY and API-URI will differ from the image below.

Org/fac List

Protocol

Name

Consent Required OFF
Mapper Type
Token Claim Name org-fac

PI-KEY

API-URI

Response format application/json ¥

m Cancel

Name Category Type

org/fac list Token mapper Org/fac list

email Token mapper User Property
groups Token mapper Group Membership
username Token mapper User Property
realm roles Token mapper Realm Role List
roles Token mapper Client Role List
given name Token mapper User Property
family name Token mapper User Property

full name Token mapper User's full name
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Validate the IWeb Web Service

Make sure that the IWeb web service URL is accessible. The output of this should
return the org/fac list. If there is an error, it needs to be fixed.

3 hetprhD o0 8 L Frnee T

Check the Whitelist Rules

If Jaspersoft is installed in an AWS environment, the outbound connection on port
8080 should be enabled for the IWeb server.

If Keycloak is installed in an AWS environment, the outbound connection on port 8080
should also be enabled for the IWeb server.

Check the Firewall Rules

If there are any special firewall rules preventing the Jasper and/or Keycloak servers
from accessing IWeb through port 8080, the need to be fixed so that the port is
enabled.

JasperReports Server Upgrade - Linux

These instructions are only required when deploying SMaRT AFIX for the first time or
when upgrading from a version of SMaRT AFIX older than 1.17.4. If you have already
deployed SMaRT AFIX 1.17.4, you should already have the web service plugin installed
on your JasperReports server and can skip these instructions.

As a part of SMaRT AFIX 1.17.4, the new SMaRT AFIX Online Tool web service was
introduced to help support the CDC's AFIX Online Tool application. In order to integrate
this tool with SMaRT AFIX, a plugin must be added to the existing JasperReports server.

Prerequisites

1. JasperReports server has been installed.

2. The web service plugin zip file has been downloaded to your application server
(APP) and the contents extracted. The unzipped folder is referenced as $WS_DS
from this point on.

/APP/JRS/webserviceds_v1.0_3.zip

3. Locate your JasperReports server web application folder, which is referred to as
$IJRS_HOME from this point on. It is recommended that you back up this folder
before beginning the plugin installation.
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/opt/jasperreports-server-6.2.1/apache-tomcat/webapps/jasperserver-pro

Plugin Installation Steps
The installation should be performed as root user.

1. Stop your web server running JasperReports server.

2. Open the folder $WS_DS/JIRS/WEB-INF/bundles and copy the contents to
$JRS_HOME/WEB-INF/bundles/. Note that this should not overwrite any existing
files.

cd /$WS_DS/JIRS/WEB-INF/bundles/
cp * /$JRS_HOME/WEB_INF/bundles/

3. Open the folder $WS_DS/JRS/WEB-INF/1ib and copy the contents to
$JIRS_HOME/WEB-INF/1ib/. Note that this should not overwrite any existing files.

cd /$WS_DS/JIRS/WEB-INF/1ib/
cp * /$JRS_HOME/WEB_INF/1ib/

4. Open the $WS_DS/JIRS/WEB-INF/ folder and copy the applicationContext-

WebServiceDataSource . xml file to $JRS_HOME/WEB-INF/. Note that this should
not overwrite any existing files.

cd /$WS_DS/JIRS/WEB-INF/
cp applicationContext-WebServiceDataSource.xml /$JRS HOME/WEB_INF/

5. Restart the web server running JasperReports server.

Validation Steps

Follow these steps to confirm that the plugin has been successfully installed:

1. Navigate to your JasperReports server admin console.

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide Page 44



2. Log in as an admin-level user.
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3. Select Create = Data Source from the top menu.
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4. Confirm that Web Service Data Source is listed in the Type drop-down list.

L' ™M Y n -_\ i { Q stchome / afix_reporting X yg TIBCO Jaspersoft: New [ X _

&« C Y | ® Mot secure | 52.37.156.46:8080/jasperserver-pro/flow.htm|?_flowld =addDataSourceFlow&ParentH

55 Apps Google Apps STC Links IWeb Git Timesheets CR145 Citrix JasperSoft KeyCloak

TIBCQ'Jaspersoft' #& Library View. Manage~ Create~

New Data Source

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: Web Service Data Source v
AWS Data Source

Bean Data Source

Cassandra Data Source

Internal Diagnostic Data Source
none |JDBC Data Source

JNDI Data Source

MongoDB Data Source

Langua MongoDB IDBC Data Source

json Virtual Data Source

Web Service Data Source

Request Verb:

Auth Ty

post

Web Service URI:

SUpEruser

Password:

Username:

SMaRT AFIX JasperReports Deployment -
Linux

The following outlines how to import (migrate) Jaspersoft Reports for SMaRT AFIX.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured

o Retrieve the passwords for the SMaRT AFIX database (afixdb)

e Retrieve the Jaspersoft superuser username and password

e Confirm that the SMaRT AFIX Online Tool web service is installed

e Confirm that all necessary ports are open across all firewalls (the default port is
80)

e Confirm that the release distribution zip file for Jasper Reports is extracted from
/APP/JIRS/AFIX_Reports-[version number].zip and copied to your local drive.
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e Important: Be sure to update the JasperReports server by following the
instructions in SMaRT AFIX JasperReports Server Upgrade - Linux.

Procedure Steps

Follow these steps to deploy Jaspersoft Reports.

Export the Jaspersoft Repository for Backup

Export the repository by selecting Manage > Server Settings > Export (Export
Everything) in Jaspersoft. Save the file as a backup.

| TIBC® Jaspersoft” # by View- Manage- Creste-

i Sertings Export

File Properties
vata File Name (required)

export.zip

Fxport Oplions:
& Export Everythinc

Roles and Users to Export

Roles:

Resources to Fxport Assets to Fxport Events to Fxport

Import the Content via the Portal

1. Log in to the Jaspersoft Bl Portal as the administrator user.
2. Navigate to Server Settings > Import.

3. Import the AFIX_Reports-[version number].zip file.

4. Update the data source with the database connection information.

Import the Content via the Command Line

1. Confirm that JAVA_HOME is set and your path includes jre\bin or jdk\bin.

2. Change to the buildomatic directory on the JasperReports server:

C:\Jaspersoft\jasperreports-server-6.2.1\buildomatic
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3. Execute the migrate command (adding in the correct version number): js-

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide

import.sh —-input-zip "AFIX_Reports-[version number].zip" --update --
skip-user-update --include-access-events --include-audit-events --
include-monitoring-events

Update the data source with the database connection information: From the left
menu, go to root > AFIX = Data Sources. Select AFIX_AWS, then click the
Edit tab. Specify your database connection properties for Host, Port, and
Password, then click Save.

TlBC"Jaspersoft- # Library Views Manage+ Create«

£ Folders Repository
(Sl root Run Edit | Open Copy  Cut Paste | Delete
£ AFIX ¢ Name Description

{5l Adhoc Views

ffal Bundles LR LG
{ful Dashboards

{flul Domains

fal Images

{fal Input Controls

(5l Queries

[Eg. i Reports

Select AFIX_EXPORT, then click the Edit tab. This is the web service data source
linked to the SMaRT AFIX Online Tool web service.

T[BC"JaSpersoft' #A& Library Views Manage- Create~

£ Folders Repository
[l root Run Edit Open  Copy  Cut Paste | Delete
Sl AFIX o
Name Description

@l Adhoc Views

@l Bundles AFIX_AWS
(Bl Dashboards AFIX_EXPORT

&M Data Sources

t:l_, Domains

\:1 « Images

5™ Input Controls
\:L, Queries

[l Reports

Leave the defaults for Auth Type, Language, and Request Verb. Update the web
service URI to point to your SMaRT AFIX Online Tool web service deployment.
Note that even though the Password field is populated, no password is present or
required; leave it as it is. Click Save when finished.

Page 48



Edit Data Source: AFIX_EXPORT

Set Data Source Type and Properties

Type:

Auth Type

none

Request Verb:

get

Web Service URI

http://10.0.0.12:8080/afix. export ws/

Usarname:

m S

First, select the type of data source you wish to add, then enter the required property values.

Validate the New Content

The following steps perform a spot check on the newly created content to validate it and
to check for any serious errors. It does not perform a full check of all possible issues and

should be followed up with a functional validation of the content.

1. Log on to the Jaspersoft Bl server as a user able to run a report. The user should
be able to log in successfully and see the subfolders under /root/AFIX (select

View > Repositories).

Sl root

Tl Adhoc Views
Bundles
Dashboards
Data Sources
Domains
Images

Input Controls

Queries

N EEEE B EEE

Reports

2. Validate that the user can execute and view a report as defined by their class or

organization membership: Select the report from
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AFIX/Reports/AFIX_Online_Tool, select one report from any of the other sub-
directories of AFIX/Reports, and confirm that both reports execute successfully.

Restore the Previous Content (if Necessary)

If there are any uncorrectable issues and the release upgrade needs to be aborted, follow
these steps to revert to the previous content:

1. Using the backup exported at the beginning of these steps, import using the steps
above. Note that a re-import of the previous version of the content will also
achieve the same back-out.

2. Perform the validation steps listed above.

Node.js Installation - Linux
Follow these steps to install Node.js on Linux.

1. Create the user environment: A user needs to be created to run Node.js
applications. However, it is not recommended that Node.js applications be run as
a privileged user.

sudo adduser node

2. Become the node user:

sudo su - node

3. To install Node.js for the previously created node user, Node Version Manager is
recommended. This allows for more flexible control over the environment and an
easier future upgrade path.

curl -o-
https://raw.githubusercontent.com/creationix/nvm/v0.32_1/install_sh |
bash

source ~/.bashrc

4. Install the required version of Node.js:

nvm install 6.9.1
nvm use 6.9.1
nvm alias default 6.9.1

5. Install the PM2 node process manager:

npm install -g pm2
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SMaRT AFIX Application Installation
Instructions - Linux

The following instructions explain how to install the application, the Oracle Instant Client,
and Redis; how to configure the application dashboard and quick links; specific
configuration options; and information on standalone versus multiple application
deployment.

If you are upgrading from a previously installed version of SMaRT AFIX, you can skip
directly to the Install the Deployment Package section and continue from there.

Prerequisites

The following should already be installed and configured:

Linux CentOS 7

e PostgreSQL server (DBB)
e Oracle server (COR)

e Node.js (APP)

e PM2 (APP)

Installation and Deployment of SMaRT AFIX, iQ, and
VOMS

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, you only
need to install the Oracle Instant Client and Redis with the first application installation.
Once these are installed, for subsequent applications that are running on the same
server, you can skip down to the Install the Deployment Package section and continue
from there instead.

Install the Oracle Instant Client

1. Download and install the Oracle Instant Client (both basic and SDK). The .rpm
files can be found at http://www.oracle.com/technetwork/topics/linuxx86-64soft-
092277.html. Install them with the RPM command.

2. Add the following to the users: _bashrc, .cshrc, and .zshrc, or use the default
per-interactive-shell startup file of the default shell of the user for which you want
to run the application. Optionally, instead of adding them on a per-user basis, the
following can be added to /Zetc/profile or /etc/profile.d/oracle.sh:

export OCI_LIB_DIR=/usr/lib/oracles/12.1/client64/1ib
export OCI_INC _DIR=/usr/include/oracle/12_1/client64
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3. Create afile in /etc/ld.so.conf.d/oracle.conf with the path to the Oracle
Instant Client libraries, which by default are as follows:

/usr/lib/oracle/12.1/client64/1ib

Install Redis
When installing Redis, make sure epel repo is enabled:

yum install redis
systemctl enable redis
systemctl start redis

Install the Deployment Package

Copy the provided zip/tar file to the target server. Extract the archive and change into
the parent of the directory where it was extracted.

Configure the Application Dashboard and Quick Links

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, the steps
below only need to be completed the first time an application is installed. This file should
be saved for all subsequent installations.

1. Download the apps.json file from the release distribution application components
shared folder.

2. Edit this file with a text editor and replace the placeholders DASHBOARD_ URL,
IWEB_URL, AFIX_URL, PHC-HUB_URL, 1Q_URL, and VOMS_URL (if applicable for
your installation) with their respective URLs.

3. Save this file and keep it handy as you will need to use it in the installation of iQ,
VOMS, and the SSO dashboard.

An example of one such configuration object in the JSON file is shown below. In most
cases, only the URL value needs to change:

{

"icon': "/static/public/img/STC - SmartAFIX.svg",

"id": "AFIXT,

“name': "SMaRT AFIX",

“url*™: "https://afix.stchome.com ™,

"description': "Utilized to make AFIX assessments efficient, standardized and
meaningful .*,

"hidelfUnavailable": true,

"*accessRole™: "Access_afix"

}

Copy this file to the following location:

<application_install_dir>/src/shared/helpers/appActions/
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Configure the Reverse Proxy

A reverse proxy is recommended to provide access to the various products. This is not
explicitly required unless the products are running with the ENABLE_SSL option set to
true. However, this will generally be the case when the products are being run in
conjunction with IWeb on the same server. See the example Apache configurations at
package/docs/apache.

General Product Configuration Options

Once the package containing the products has been installed, there are some
configuration options that can be set depending on the environment. The majority of
these lie in package/process. json, which is simply a JSON configuration file for pm2.
The options listed in bold below need to be changed to match your environment. Other
options not in bold might not need to change, and in most cases can be the default
setting. Some options in the process. json file are not listed at all below; those options
should be left unchanged.

The options are as follows:

Option Description

script Location of the startup script application. The path to the script
may need to be customized.

cwd The path to the application. May need to be customized.

PRODUCT The name of the product.

HOST The host name for the product.

APIHOST The host name of the product's respective API server (generally
localhost).

PORT The port for the product.

APIPORT The port for the product's API server.

NODE_ENV This should always be production.

SAML_ISSUER

The SAML issuer (client) from Keycloak.

SAML_ENTRY_POINT

The SAML entry point from Keycloak.

JASPER_SERVER

The domain name of the JasperReports server.

REDIS_URL

The Redis URL used for storing client sessions.

REVERSE_PROXY

When configuring SMaRT AFIX with a reverse proxy, this should
set to true.

be

ENABLE_SSL

When set to true, this enables HTTPS support. If REVERSE_PROXY

is set to true, this should be set to false even when the
environment is configured for HTTPS.

SECRET_SESSION

The secret key for session storage. IMPORTANT NOTE: This value
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‘Description

must be exactly the same for every application, in both the server
and the API environment variables.

SMaRT AFIX-Specific Configuration Options

The following options are specific to SMaRT AFIX configuration settings:

(@]e]ue]g! Description

VOMS_ORACLE_USER

The username for IWeb's SIIS database. This is set to the
default user for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_PASSWORD

The password for IWeb's SIIS database. This is set to the
default password for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_CONNECTION

Connection information for IWeb's SIIS database. This needs
to be updated to point to your IWeb's Oracle database
instance.

PG_USER

The user account for the SMaRT AFIX PostgreSQL database.

PG_PASSWORD

The password for the associated PG_USER for the SMaRT AFIX
PostgreSQL database.

PG_HOST

The hostname for the SMaRT AFIX PostgreSQL database.

PG_PORT

The port number for the SMaRT AFIX PostgreSQL database.

AFIX_EXPORT_URI

The URL for the SMaRT AFIX Online Tool web service. Only the
hostname and possibly the port number for the URL need to be
updated.

AFIX_EXPORT_KEY

The API Key for the SMaRT AFIX Online Tool web service. This
should be left as the default.

CDSI_FORECASTER_VERSION

The current version of the CDSI Forecaster deployed. For the

SMaRT AFIX 1.17.5.4 release, it should be set to 5.17.10.

SMaRT AFIX for Independent Partners-Specific Options

These options are used for independent builds of SMaRT AFIX (i.e., not connected to
IWeb) only and should be left unchanged for builds involving 1Web.

Option \Description

API_URL_PREFIX This sets the API prefix for independent mappers.

MANAGE_URL_PREFIX This sets the Manage Users page URL.

IS_INDEPENDENT When this option is set to true, it enables independent build
functions.

MANAGE_USER_EMAIL This enables the password reset functionality for the Manage Users
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Option ‘Description

page.

SERVICE_API

This enables custom report template sharing for independent
SMaRT AFIX. It should be set to api/orgFacSearch.

Run the Application

Use pm2 to run the deployment package as shown below. In many cases, environment-
specific configuration options must be set prior to running an application's package. See
the configuration option sections above for more details.

pm2 start package-parent/process.json

Start the Products upon Bootup

To have the products automatically start on every boot, do the following once it has been
verified that they are running correctly:

pm2 save

pm2 startup
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Windows Instructions

The following instructions are for the Windows operating system.

Forecaster Installation Instructions -
Windows

The installation of the Standalone Forecaster (SAF) is composed of three major tasks:
install Oracle Express, install the SAF database into Oracle Express, and install the
Forecaster web application into Tomcat. All three components are installed on the Service
machine (SVC).

SAF can be installed to Oracle 11g or Oracle Express 11g. The Oracle product you choose
will depend on your state's licensing. Oracle Express 119 is free to use for this type of
installation. All performance testing, etc., for SAF has been conducted using Oracle
Express. These instructions only cover the installation of Oracle Express 11g.

Install Oracle Express

1.
2.

If necessary, create an Oracle account at http://www.oracle.com.

If using Oracle Express (free), download the appropriate version. The Windows
version is approximately 312MB in size.

Unzip the downloaded file and run the DISK1/setup.exe. When using the
installation wizard, the installer creates a database named XE. The installer uses
these ports: TNS = 1521, MTS = 2030, HTTP = 8080.

There may be two error messages about a missing file named KEY_XE.reg. Just
acknowledge them and continue with the installation.

Disable the HTTP port by running the following at a command prompt after the
installation is complete:

echo EXEC DBMS_XDB.SETHTTPPORT(0); | sqlplus / as sysdba
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Install the SAF Database

Database objects are created with 5.16.9 CDSi install version.

1. Navigate to the
/SVC/0OXE/db/AFIX_CDSI_Install/AF1X_CDSI_v5.16.9_Install/ directory.

2. Run Install .bat.

Run Database Patches

1. Navigate to the /SVC/0XE/db/Patches/patch_v5 17 CDSI directory.

2. Run the forecast.bat script.

Install the Web Application

Before installing the SMaRT AFIX web application, Java 7 must be installed on the SVC
server and Tomcat 7.0 must also be installed and running on the SVC server.

1. Edit the conf/context.xml file - Add the lines below (between the
<Context></Context> tags) to the CATALINA HOME/conf/context.xml file. The
added lines should be placed within the <Context></Context> tags in the file.

<Context>
<Resource name="jdbc/com/stc/forecaster"
auth="Container"™
type="javax.sql .DataSource"
driverClassName=""oracle.jdbc.OracleDriver"
url="jdbc:oracle:thin:@localhost:1521/XE"
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username=""SAFUSER""
password=""SAF"
maxActive="100"

maxldle=""10"
maxWait=""-1"/>
</Context>

2. Copy the /SVC/SAF/forecaster._war to webapps/forecaster .war under your
Tomcat directory.

3. Restart Tomcat.

4. Set the number of threads to the number of processor cores available on your
server - Edit $CATALINA HOME/webapps/forecaster/WEB-INF/spring-ws-
servlet.xml and set the thread count (see the second line of code below):

<bean id=""forecastingEndpointl2"
class=""com.stchome.saf.ws._endpoint._ForecasterServiceEndpointl2"

scope="prototype'>

<constructor-arg value="1" /><I-- Thread count -->

<constructor-arg value="60" /><!-- Thread pool termination timeout in
seconds-->
</bean>

5. Restart Tomcat.

6. Verify the application is running correctly by navigating to http://[YOUR
SERVER]/forecaster. The Ul displays if the application was successfully installed
and configured.
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Postgres Database Installation - Windows

The information below describes how to install the Postgres database on Windows Server
2008 R2 64-bit, as well as how to modify relevant Postgres server configuration settings
for SMaRT AFIX.

Install on Windows
The following information covers general installation instructions for installing PostgreSQL

on Windows. Windows Server 2008 R2 64-bit was used as a reference, but installation on
other versions of Windows should be similar.

1. Visit this page and download the latest 64-bit version of Postgres. Version 9.4.x
was used for this installation example.
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2. Run the downloaded executable to start the installation. It is recommended to use
the default installation directories, but they can be customized as needed (make
note of the new locations).

3. Choose a password for the Postgres admin user postgres and store it securely for
when administrative maintenance is required.

4. Use the default port 5432 (recommended). An alternate port can be used, but
make sure to configure connecting applications to the Postgres database.

5. Use the default locale.

6. On the last step post installation, you can uncheck the Stack Builder may be...
option and click Finish.

Modify Postgres Server Configuration Settings

Some of the Postgres server configuration settings must be modified. If you used the
default installation directory, the following file reference locations should be located in
the directory path:

C:\Program Files\PostgreSQL\9.4\data\

1. Edit the pg_hba.conf file to allow connections from other STC
servers/applications. Copy/paste the following line:

host all all 127.0.0.1/32 md5

to make the file look something like the following. Let's assume your internal sub-
net falls under 192.168.x.x, which would update the line to:

host all all 127.0.0.1/32 md5
host all all 192.168.0.0/16 md5
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2. Save the changes. If you are technical and familiar enough with CIDR notation,
you can further customize and restrict connection access as needed.

3. Trigger Postgres to reload with the new configuration changes by running Reload
Configuration, found under PostgreSQL 9.4 in the Windows Start Menu:

, Maintenance

, PostgreSglL 9.4

a Application Stack Builder

W poadmin 111

{4 Reload Corfiquration

B 501 shell (psql)
. Documentation

, Startup

4. Create a custom firewall rule to allow inbound connections on port 5432:

Postgresqgl Properties .

| General | Programs and Services I Remote Computers
Protocols and Ports | Scope I Advanced I Local Principals I Remote Users

Protocols and ports

S Frotocel type: |TCP ] |

Protocol number:

(=]

A
3

Local port: |S|:|ec:ific Ports Vl
5432 |
Bample: 80, 443, 5000-5010

Remote port: |AII Ports W |

Example: 80, 443, 5000-5010

Intemet Control Message Protocaol
{ICMP) settings:

5. Complete the installation by initializing the database (see SMaRT AFIX Database
Initialization - Windows).

SMaRT AFIX Database Initialization -
Windows

The information below describes how to initialize the database for the first time, how to
upgrade/migrate an existing database, and how to set up daily jobs.

Prerequisite Tasks

Perform the following tasks before initializing the database:
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1. Confirm that PostgreSQL has been installed.

Initialize a New Database (for the First Time Only)

If this is the first time you are initializing the database, follow the steps below.
Otherwise, see the Upgrade/Migrate an Existing Database instructions.

1. Create a tablespace folder - Use Windows Explorer to create the directory for the
tablespace to be used by SMaRT AFIX. Navigate to the folder C:\Program
Files\PostgreSQL\9 .4, click the New Folder button, and name the new folder
afixdb.

2. Set the folder permissions for afixdb - In Windows Explorer, right-click on the
afixdb folder and select Properties. Click on the Security tab, then click the Edit
button and then the Add button. Enter the name network service and click on the
Check Names button.

3. Your window should like the image below, although your location will be different
and local to your network. Click OK.

Permissions far afixdb 2

Security

Object name: C:\Program Files\PostgreSQL\S 4\afixdb

Group aruser names:

2

wE)

Select Users, Computers, Service Accounts, or Groups

Selectthis objecttype:

Users, Groups, or Built-in security principals Object Types...

From this location:

Enter the object names to select (examples):
NETWORK SERVICE Check Names

o) o]

T — — L

4. Make sure NETWORK SERVICE is selected and that the Full Control option under
the Allow column is selected. When finished, click OK for all of the remaining
open windows to close them.
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| afixdb Properties | P |

GenerallSharing Security |P:evious\-'e:sions Customi.ze|

g —
| Permissions for afixdb M
Securty

Object name: C:\Program Files\PostgreSQL\3.4\afixdb

GI'CIL.Ip aruser names:

51, CREATOR OWNER

2, SYSTEM

q
52, Administrators (bleeE5470\Administratars)

2 Users (bleeE5470\Users)

82 Trustedinstaller

[ Add ] l Remaove ]
Permissions for NETWORK
SERVICE Allow Deny
Full control [ il
q Modify B
Read & execute [ 3
u Listfolder contents [
L Read [ Ll

Learn about access control and permissions

OK ] [ Cancel ] Apply

5. Create the data directory:

C:\Program Files\PostgreSQL\9.4\afixdb\data

6. Create the olapdata directory:

C:\Program Files\PostgreSQL\9.4\afixdb\olapdata

7. Download the release distribution zip file and extract the database scripts for the
database server in the afixdb folder:

\DBB\POSTGRES

8. Create the afixdb by navigating to the /DBB/POSTGRES directory and executing the
following command. If prompted, enter the password that was entered during the
Postgres installation.
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"c:\Program Files\PostgreSQL\9.4\bin\psqgl.exe" -Upostgres -f
setup_database_win.sql

9. Create the database users and roles by navigating to the /DBB/POSTGRES
directory and executing the following command. If prompted, enter the password
that was entered during the Postgres installation.

"c:\Program Files\PostgreSQL\9.4\bin\psqgl.exe" -Upostgres -f
setup_objects.sql afixdb

10. Create the APP configuration schema by navigating to the /DBB/POSTGRES
directory and executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sqlMigrationPrefix=APP_V -user=afix migrate

11. Create the ODS schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqglMigrationPrefix=0DS_V -user=afix migrate

12. Create the OLAP schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix migrate

Upgrade/Migrate an Existing Database

If this is not the first time you are initializing the database, follow the steps below.
Otherwise, see the Initialize a New Database (for the First Time Only) instructions.

1. Migrate the APP configuration schema by navigating to the /DBB/POSTGRES
directory and executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sglMigrationPrefix=APP_V -user=afix migrate

2. Migrate the ODS schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqglMigrationPrefix=0DS_V -user=afix migrate

3. Migrate the OLAP schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix repair
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flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqglMigrationPrefix=0LAP_V -user=afix migrate

Set Up a Daily Job / Drop Partition

1. Copy partition.sgl and partition._.bat from the /DBB/POSTGRES directory to
C:\Program Files\PostgreSQL\9.4\afixdb.

2. Navigate to the /DBB/POSTGRES directory and execute this command:

copy partition.sql C:\Program Files\PostgreSQL\9.4\afixdb
copy partition.bat C:\Program Files\PostgreSQL\9.4\afixdb

3. Create a Task Scheduler to run the C:\Program
Files\PostgreSQL\9.4\afixdb\partition.bat script daily at 1:00 a.m. to
create future partitions and drop old partitions.

SMaRT AFIX Online Tool Web Service
Installation - Windows

The SMaRT AFIX Online Tool web service is used by the SMaRT AFIX application to
generate an XML file to be uploaded to the CDC's AFIX online tool application. The web
service is a simple web application that is installed alongside the Stand Alone Forecaster
on the Service machine (SVC).

Prerequisites

The Postgres database is installed and configured.
The Postgres password for the SMaRT AFIX database is known.
The Tomcat instance is installed on the SVC server.

All necessary ports are open across all firewalls.

a &> NPk

The release distribution file for the SMaRT AFIX Online Tool web service is
extracted from /SVC/ONLINE_TOOL/afix.export.ws.war and copied to your local
drive.

Installation Steps

1. Copy the afix.export.ws.war file to your Tomcat webapps folder.
2. Restart Tomcat.

3. Update the application properties to point to the proper Postgres database. Make
sure the username and password are correct.
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4. Edit the $CATALINA_HOME/webapps/afix.export.ws/WEB-INF/app.properties
file:

driverClassName=org.postgresql .Driver
url=jdbc:postgresql://127.0.0.1:5432/afixdb
username=afixUser

password=afixPassword

5. Restart Tomcat.

Jaspersoft ETL Installation - Windows

Follow these instructions to install Jaspersoft ETL, Apache Web Server, and Subversion,
and to configure the administration console. This installation only needs to occur once.

Prerequisites

1. Java JDK 8 (1.8.91) has been installed.

2. The environment variable JAVA _HOME has been set:

JAVA_HOME=[drive]:\directory\Java\1l.8 91

3. Copy the components from the distribution /Server Components/ETL directory
into your local directory. These files include:

e license.txt
e TIBCOJaspersoft-JETL-Installer-20150908...zip
o etl.zip

e VisualSVN-Server-3.5.6-x64

Install Jaspersoft ETL

1. Download the Jaspersoft ETL installer zip file and the license file:

Server Components\ETL\TIBCOJaspersoft-JETL-Installer-20150908_ 1633-
V6.0.1-installer.zip
Server Components\ETL\license.txt

2. Copy the installer and license file into a temporary directory:

c:\user\[user name]\Downloads

3. Unzip the installer into the temporary directory. Several files will be extracted.
Keep all of the files in the temporary directory for the duration of the installation.

4. From the temporary directory, execute the Windows installer by clicking on:
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TIBCOJaspersoft-JETL-Installer-20150908_1633-V6.0.1-windows-
installer._exe

5. Follow the prompts to accept the license agreement.

6. Follow the prompts to specify the installation directory, installation type, and
license file. Specify [drive:]\Jaspersoft\6.0.1 for the installation directory,
Easy Install for the installation type, and license.txt (found in the temporary
directory).

7. Click the Next button and wait until the installation finishes.

8. Click the Start button, search for services.msc, and then search for any service
named TIBCO Jaspersoft Logserver Collector 6.0.1. Stop this service and set it to
Manual. If there is no service named this, ignore this step.

Install Subversion

Download the SVN installer: Setup-Subversion-1.8.16.msi.

Click on the installer to execute.

Follow the prompt for the security warning by selecting Run.

Click Next on the Welcome prompt.

Click Next on the Information prompt.

Use the default destination folder or specify a different folder, then click Next.
Use the default version on the Apache Version prompt, then click Next.

Click Finish on the Complete Install page.

© 0o N o o~ DN PR

Configure the SVN repository for all of the Talend projects and library:

svnadmin create "c:\projects"
svnadmin create "c:\talendlibrary"

10. Configure the user settings - edit the c:\talendlibrary\conf\passwd file and
add the following line:

admin@company.com = admin

11. Configure the server settings:

anon-access = none
auth-access = write
password-db = passwd
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Start/Stop Jaspersoft ETL Services

The following are the instructions to start and/or stop Jaspersoft ETL services. These
steps are not mandatory on a first-time installation because the services will be running
by default.

Start/Stop Jaspersoft ETL Admin Console

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\jac
$ stop_tac.bat

Command to start the service:

$ cd C:\Jaspersoft\6.0.1\jac
$ start_tac.bat

Start/Stop Jaspersoft ETL Command Line

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\cmdline
$ stop_cmdline.bat

Command to start the service:

$ cd C:\Jaspersoft\6.0.1\cmdline
$ start_cmdline.bat

Start/Stop Jaspersoft ETL Job Server

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\jobserver
$ stop_jobserver.bat

Command to start the service:

$$ cd C:\Jaspersoft\6.0.1\jobserver
$ start_jobserver.bat

Configure the Admin Console

These steps are used one time only. They should be completed during the server
installation.

1. Navigate to http://[host name]:8080/0rg. jaspersoft_administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).
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2. Navigate to Configuration on the left menu and update the SVN and library
information.

Branches whitelist: false ~| @
Server location url: http://10.0.5.137 /repo o
Username: tisadmin &
o o
Fassworg: LTI e
Commit Log Pattern: o]

E]‘J Jzer Libraries (4 Parameters @

Libraries Repository: SVN v @
Library location url: http://10.0.5.137 /talendlibrary )
Library username: tisadmin iy

o
Library password: ssassanssasans ©

3. Navigate to User Settings on the left menu and update the username (if
needed), SVN, and library information.

adrmin x]
admin =
change password
timadimin

AA

Ty -
Rl

=3
Conncctions stats
To the Administration Conter
First: 20160525 1 |
Last: 2OLE-08-25 141518 . |
MU miser: 1
T the Stwnelio
First: o |
Last: |

Fumiber: .
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4. Click on Role and select all of the roles.

Roles Selection X

Role

Administrator

Operation manager

Designer

«" Validate

5. Navigate to Project settings from the left menu and add a new project by

clicking the Add button.

Create two projects. Name the first one InteropProject, select the Active

option, enter Interop ETL as the description and admin admin as the Author,

and select SVN as the storage, then save it.

Project

Label:

Active:

Reference:

Description: Interop ETL
Author:

Storage:

Advanced settings

e e e e

0= J[oze]

Name the second project Interop_Reference, select both the Active and

Reference options, do not enter a description, use admin admin as the Author,

and select SVN as the storage again, then save it.
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Project
Label:
Active:
Reference:
Description:
Author:
Storage:

Advanced sattings

e

8. Navigate to Project authorization from the left menu. Click on each of the
newly created projects and assign read/write permissions to the user.

“-» PROJECT AUTHORIZATIONS

s for the Project: InteropProject

Autharizations by Project

InteropProject

TIBC® Jaspersoft

9. Create the following directories and files in the server:

C:\Jaspersoft\6.0.1\deploy
C:\Jaspersoft\6.0.1\deploy\generatedJobs
C:\Jaspersoft\6.0.1\deploy\executionLogs
C:\Jaspersoft\6.0.1\cmdline\exports
C:\Jaspersoft\6.0.1\Audit
C:\Jaspersoft\6.0.1\Audit\reports
C:\Jaspersoft\6.0.1\joblogs
C:\Jaspersoft\6.0.1\joblogs\log.txt

10. In Primary Command Line configuration, set the path for the Job generation folder

to C:/Jaspersoft/6.0.1/cmdline/exports

o CommandLine/primary (5 Parameters ©

Host: localhost [~]

Port: 002 @

Job generation folder: C:/Jaspersoft/6.0.1/cmdline/exports/ @ validity of path cannot be checked
User component path: = (] Validity of path cannot be checked
Version 6.0.1.201509028_1633 v)
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11. In Job Conductor configuration, set the path for the Generated jobs folder to
c:/Jaspersoft/6.0.1/deploy/generatedJobs and the path to the Tasks logs
folder to c:/Jaspersoft/6.0.1/deploy/executionLogs

B Job conducter (7 Paramsters e
Generated jobs folder: c:fJaspersoft/6.0.1/deploy/generatedjobs @
Tasks logs folder: c:fJaspersoft/6.0.1/deploy/executionLogs @
NMumber of executions log: 1000 ()
Maximum age of log file(d): 0 (]
Maximum number of generated 3 (]
jobs:
Maximum age of generated job(d): |0 @
12. In Logging configuration, set the Technical log file path to
c:/Jaspersoft/6.0.1/joblogs/log
- Logging (4 Parameters / 1 errors @
Technical log file path: c:fJaspersoft/6.0.1/joblogs/log (]
Technical log threshold: WARN v @
Business log file path: e

13. In Audit configuration, set the Reports stored path to
c:/Jaspersoft/6.0.1/Audit/reports

= Audit|&Paramelens ©

Url: jdbeih2:C:fJaspersoft/6.0.1/jac/apache-tomcat/webap| &
User: tisadmin = (]
Password:  |eeesees = ©
Driver: org.h2.Driver ~ @
Web Console http://ig-demao-

dbb:28080/org.jaspersoft.administrator/h2console

Reports stored path: c:/Jaspersoft/6.0.1/Audit/reports @

14. Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: Name of the job server

e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000

e File transfer port: 8001
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15.
16.

17.

18.

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide

e Monitoring port: 8888

e Active: Select this option (enable)
e Username: the admin username for the ETL

e Password: the password for the admin ETL user

File

\3)s

Execution server

Label: qal-etl
Description:

Host: 10.0.5.137
Time zone:

Command port: | 8000

port:

Monitoring port: | B&88
Timeout on 120
unk
Username: admin@stchome.com
Password:

UJse S5L:

Active:

&

transfer 8001

nown state

Jaspersoft Runtime

Log in via Remote Desktop to Windows Server using ETL server owner.

Copy the etl .zip file (from /DBB/ETL) to a location convenient for you on the

ETL Jaspersoft server to unzip the file, such as a home directory.

Unzip the etl.zip file to the server in (C:\) directory (Windows), which creates a
directory structure similar to this:

Set up SMTP in Configuration only if the user needs an email notification on
failure of jobs. Use the following settings:

C:\etl
C:\et\data

C:\etl\archive

e Use SMTP > False

e Host: company's email SMTP server

e Port: host's port number
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e Username: host's username

e Password: user's password

B4 su7P (6 Parameters / 3 errors @

Use SMTP: true v
Host:

Port:

Require S5L: false

Username: user@domain.com

Password:  |eeesesees

SMaRT AFIX Jaspersoft ETL Deployment -
Windows

The following outlines how to import (migrate) Jaspersoft ETL for SMaRT AFIX.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured
e Retrieve the passwords for the SMaRT AFIX database (afixdb)
e Retrieve the Jaspersoft ETL admin username and password

e Confirm that port 8080 is open across all firewalls

e Confirm that all of the steps in the Admin Console configuration are completed on
a first-time installation

e Copy these components from /DBB/ETL into your local directory:

API1_Vaildation_Sequential_Execution_0.1
etl
etl_201703

Forecaster_Sequential_Execution_0.1
ODS_Sequential_Execution_0.1
OLAP_Sequential_Execution_0.1
AFIX_Assessment_Benchmark_ 0.1
UserApi_Sequential_Execution_0.1

e Place all of the API files in Zetl/afix/api/

e The API_EXTRACT_Complete.tkn file should be placed along with the other API
files so that it can help trigger ETL jobs.
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¢ ldentify whether the installation is an upgrade from prior versions or a fresh
installation from scratch.

New Installation Instructions (for the First Time Only)

If this is the first time you deploying Jaspersoft ETL, follow the steps below. Otherwise,
see the Upgrade Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Navigate to Project settings from the left menu and add a new project by
clicking the Add button.

3. Name the new project AFIX_ETL. Select the Active option, enter admin admin
as the Author, and select SVN as the Storage.

Project
Label:
Active:
Reference:
Description:
Author:
Storage:

Advanced settings

4. Navigate to Project authorization from the left menu. Click on the newly
created project and assign read/write permission to the user.

User Authorizations for the Project: AFIX_ETL

Type  Login Last name Firstna.. Active  Right

d admin@stchome.com admin admin © £

5. Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: AFIX_ jobServer
e Host: ETL Server IP (it usually ends with dbb)

e Command port: 8000
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e File transfer port: 8001

e Monitoring port: 8888

e Active: Select this option (enable)

e Username: the admin username for the ETL

e Password: the password for the admin ETL user

Execution server

Label: qaf-etl
Description:

Host: 10.0.5.137
Time zone:

4

Command port: |&000

File transfer E001
port:

Monitoring port: |Baga
Timeout on 120

unknown state

(s):

Username: admin@stchome.com

Password:
Use S5L:
Active:

Jaspersoft Runtime

6. Log in via SSH to the Unix server using the ETL server owner.

7. Copy the etl._zip file (from /DBB/ETL) to a location convenient for you on the
ETL Jaspersoft server to unzip the file, such as a home directory.

8. Unzip the etl .zip file to the server in the root directory (Unix), which creates a
directory structure similar to this:

o c:\eth\afix

o c:\etl\afix\api

o c:\eth\afix\archive
o c:\etN\afix\bulkload
o c:\etN\afix\dataout
o c:\etN\afix\input

e c:\etl\afix\rejects
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o c:\etN\afix\tmp

e c:\etN\afix\validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e UserApi_Sequential_Execution.zip
e APl _Validation_Sequential _Execution.zip
e ODS_Sequential_Execution.zip
e Forecaster_Sequential_Execution_0.1.zip
e OLAP_Sequential_Execution.zip
e AFIX_Assesment_Benchmark.zip

3. Navigate to the Job Conductor page.

4. Select Add = Normal Task and add the following: Label = User APl Execution;
Description = User APl Execution.

5. Click Import Generated Jobs and select the
UserApi_Sequential _Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

6. Click Save.
7. Navigate to the task AFIX IWeb API Validation.

8. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Validation; Description = AFIX IWEB API Validation.

9. Click Import Generated Jobs and select the
API_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

10. Click Save.

11. Select Add = Normal Task and add the following: Label = AFIX Stage 2 ODS
Load; Description = AFIX Stage 2 ODS Load.

12. Click Import Generated Jobs and select the
0ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

13. Click Save.
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14. Select Add > Normal Task and add the following: Label = AFIX Forecast
Execution; Description = AFIX Forecast Execution.

15. Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

16. Click Save.

17. Select Add = Normal Task and add the following: Label = AFIX OLAP Execution;
Description = AFIX OLAP Execution.

18. Click Import Generated Jobs and select the
OLAP_Sequential _Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

19. Click Save.

20. Select Add > Normal Task and add the following: Label = AFIX Assessment
Benchmark; Description = AFIX Assessment Benchmark.

21. Click Import Generated Jobs and select the
AFIX_Assessment_Benchmark.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

22. Click Save.

23. For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To

e Email_SMTP_Host

e Email _SMTP_Port

e AFIX_Email_Notification

e Email_Active

e Email_UserName

e Email_Password

e Web service related parameters (Forecaster):
e SOAP_ACTION
e ENDPOINT

e Database-related parameters:
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e AFIX_DB - Login, Password, Port, Database, and Server

° Source_DB_Context - Login, Password, Port, Database, and Server

24. Save when finished.
25. Initial load instructions:
¢ Run the AssessmentBenchmark task

e Go to the task IWeb API Validation and add a file trigger with the
following values: Label = TriggerValidationAPIl, Folder Path = /etl/afix/api,
File Mask = START_ETL_RUN.tkn , Pollint(s) = 200

e Go to the task AFIX Stage 2 ODS Load and add a file trigger with these
values: Label = TriggerODSLoad, Folder Path = /etl/afix/dataout, File Mask
= API_VALIDATION_Complete.tkn, Pollint(s) = 200

Add file trigger

e Go to the task AFIX Forecast Execution and add a file trigger with the
following values: Label = TriggerForecast, Folder Path = /etl/afix/dataout,
File Mask = API_LOADS_TO_ODS_ Complete.tkn, Pollint(s) = 200. Add the
JVM parameters -Xms1024M and -Xmx15690M

At file trigger
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Go to the task AFIX OLAP Execution and add a file trigger with the

following values: Label = TriggerOLAP, Folder Path = /etl/afix/dataout, File

Mask = Forecast_lLoads_Complete.tkn, Pollint(s) = 200. Add the JVM
parameters -Xms1024M and Xmx15690M

Add file trigger
Label: TriggerOLAP
Description: TriggerOLAP

Pollint (s): 1800

cast_Loads_Complete thn

Go to the task UserApi Sequential Execution and add a file trigger with

the following values: Label = TriggeruserAPI, Folder Path =

/etl/afix/dataout, File Mask = OLAP Complete.tkn, Pollint(s) = 200. After

that, run the task UserApi Sequential Execution.

Add file trigger

 abel: TriggerUserLoad
Description: TriggerUserLoad
Pollint (s): 400
etl/afix/dataout

OLAP_Complete.tkn

server: | AFIX_jobserver v

26. Once the initial loads have completed, the ODS and OLAP tables are populated.

Now the daily sequence can be scheduled. Go to the AFIX IWeb APl Execution

task and add the Cron trigger Trigger_IWeb_API. Enter the following values and

save:

Timezone Strategy: TAC Time
Minutes: O

Hours: O

Days of Month: Leave blank
Months: 1,2,3,4,5,6,7,8,9,10,11,12
Days of the Week: 1,2,3,4,5,6,7

Years: leave blank
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Adiel Cron trigges

[EEESEE

27. Turn on the notify/email feature. Important Note: SMTP needs to be configured
beforehand.

Select Notifications from the left menu
Click Add

Select the Tasks category

Select On task failed

Select Enabled

Select Recipients to specify the user's email. It is better to create an
email group as a recipient so that notifications are sent to multiple people

Select AFIX ETL Workflow

If the upgrade needs to be aborted for any reason, import the previously created backup.
Alternatively, redeploy the previous version of the content.

Upgrade Instructions

If this is not the first time you are deploying Jaspersoft ETL (i.e., it was deployed earlier),
follow the steps below. Otherwise, see the New Installation Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg.jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Log in via SSH to the Unix server using the ETL server owner.

3. Copy the etl._zip file (located at /DBB/ETL) to the Jaspersoft ETL server. Use a
location convenient for you to unzip the file, such as a home directory.

4. Unzip the etl.zip file to the server in the Unix root directory (Unix), which adds
the following files that were created as part of this release:
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o c:\eth\afix

o c:\etl\afix\api

o c:\et\afix\archive
o c:\etN\afix\bulkload
o c:\etN\afix\dataout
e c:\etN\afix\input

o c:\etl\afix\rejects

e c:\etN\afix\tmp

e c:\etN\afix\validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e APl _Validation_Sequential_Execution.zip
e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip
e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

e UserApi_Sequential _Execution_0.1

3. Navigate to the Job Conductor page.

4. Select Add = Normal Task and add the following: Label = AFIX Assessment

Benchmark; Description = AFIX Assessment Benchmark.

5. Click Import Generated Jobs and select the AFI1X_Assessment_Benchmark.zip
file downloaded as part of the prerequisites. Add the following: Execution server

= AFIX_JobServer; On Unavailable JobServer = Recover Task.
6. Click Save.
7. Navigate to the task AFIX IWeb API Validation.

8. Click Import Generated Jobs and select the
UserApi_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

9. Click Save.
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10. Navigate to the task AFIX IWeb API Validation.

11. Click Import Generated Jobs and select the
API_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

12. Click Save.
13. Navigate to the task AFIX Stage 2 ODS Load.

14. Click Import Generated Jobs and select the
ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

15. Click Save.
16. Navigate to the task AFIX Forecast Execution.

17. Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

18. Click Save.
19. Navigate to the task AF1X OLAP Execution.

20. Click Import Generated Jobs and select the
OLAP_Sequential _Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

21. Click Save.

22. For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To

e Email_SMTP_Host

e Email_SMTP_Port

e AFIX_Email_Notification
e Email_Active

e Email_UserName

e Email_Password
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e Custom Date: Set to the current date +1. For example, if the current date
is 2017-03-06, the context value should be set to 2017-03-07.

23. Save when finished.

24. Initial load instructions: Go to the task AFIX IWeb APl Execution. Run the task
and wait to see if the job executes without any issues. Once it has made
progress, make sure each of these tasks is triggered and completes:

¢ |IWeb API Validation
e State 2 ODS Load

e Forecast Execution
e OLAP Execution

25. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Resume the CRON trigger
Trigger_IWeb_API. Go to the task OLAP_Sequential_Execution and change the
context parameter custom date to the original value in
OLAP_Sequential_Execution and save.

If the upgrade needs to be aborted for any reason, import the previously created backup.
Alternatively, redeploy the previous version of the content.

JasperReports Server Installation -
Windows

The following instructions explain how to install the JasperReports Server on Windows.

Prerequisite

Download all of the JasperReports Server contents from the distribution site. The JRS
folder contains the following files:

e applicationContext-externalAuth-oAuth

e applicationContext-security

e applicationContext-security-web

e InstallCert$SavingTrustManager.class

e InstallCert.class

e jasperreports-server-6.2.1-windows-64bit-installer.exe
e jasperserver.license

e LatoFont

e stc-jaspersoft-oauth-0.0.1-SNAPSHOT
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Installation Steps

1. Download the JasperReports Server for Windows and the license file from the
release distribution:

Server Components\JRS\jasperreports-server-6.2.1-windows-64bit-

installer._exe
Server Components\JRS\jasperserver.license

2. Run the JasperReports Server Installer by right-clicking on the file and selecting
Run as administrator:

Jasperreports-server-6.2._.1-windows-64bit-installer_exe

3. Follow the prompts to accept the license agreement.
4. Select the Install All Components and Samples option.

5. Follow the prompts to specify the installation folder. Specify the following
directory:

C:\Jaspersoft\jasperreports-server-6.2

6. On completion of the installation, start the JasperReports server by selecting the
following:

Launch JasperReports Server Now (for bundled Tomcat and PostgreSQL only)
IT you’re installing on Linux, don"t close the terminal window running
the start script.

7. Validate the installation by logging in to the JasperReports Server console. Use
your browser to access the server. Replace <hostname> below with the name or
IP address of the server:

http://<hostname>:8080/jasperserver-pro

8. Log in with the user ID of superuser and the default password of superuser.

TIBC® Jaspersoft’

5 aem st arganTanons
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Update the License File

Follow these steps to update the license file for the JasperReports server:

1. Copy the license file (Jasperserver.license) from the distribution site and move
it to your home directory/desktop.

2. Replace the license file in the JasperReports installation directory
(C:\Jaspersoft\jasperreports-server-6.2\) with the license file from the
above step, overwriting the existing jasperserver.license file.

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Increase the JasperReports Session Timeout Period

By default, the JasperReports timeout period is set to 20 minutes. However, the timeout
period should be reset to 32 minutes in order to match with Keycloak.

1. Open web.xml from the path C:\Jaspersoft\jasperreports-server-
6.2\apache-tomcat\webapps\jasperserver-pro\WEB-INF\web.xml.

2. Search for the property <session-timeout> under <session-config> and update

the value to 32. After this, the property and value should be similar to the image
below:

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).
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Start/Stop the JasperReports Server
To start or stop the JasperReports server, click the Start button, go to All Programs >

JasperReports Server > Start or Stop Services, and then select either Start Service
or Stop Service.

JasperReports Configuration with Keycloak

A few configuration changes need to be made in order for JasperReports to be used with
Keycloak.

Prerequisite

Keycloak must be installed and set up, if the SSO-enabled version of IWeb and VOMS is
being used.

JasperReports Server Modifications

1. Edit the following values in the applicationContext-externalAuth-oAuth.xml

file:

Key XML Tag Name(s) to Value
Update

[KEYCLOAK_URL] <authorization_location> URL of the Keycloak server.
<token_location> Example: https://sso-

. . dev.stchome.com/
<userdetails_location>

<logoutUrl>

[KEYCLOAK_REALM] <authorization_location> Keycloak realm that the client belongs
<token location> to. This value needs to be changed,

. . along with <keycloak_URL>.
<userdetails_location> -

In this example, the realm name is Dev-

Integration: https://sso-
dev.stchome.com/auth/realms/Dev-

<logoutUrl>

Integration
[JASPERSERVER_URL] | <property URL of the Jasper server. Example:
name="redirecturl"> http://<server_name>:8080/jasperse

<property name="logoutUr|"> rver-pro/oauth

[CLIENT_ID] <property name="client_id"> |Client ID as set on Keycloak. Example:

<property name="client_id">
<value>jasper-aws-dev</value>

[CLIENT_SECRET] <property Credentials secret key generated by
name="clientsecret"> Keycloak.
<property

name="userdetails_secret">

State_ID <property name="state"> This is the global setting used to
populate the STATE_ID attribute in
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Key

XML Tag Name(s) to
Update

Vvalue

Jaspersoft. Example:

<bean id="oAuthUserDetailsService"
class="com.jaspersoft.jasperserver.ps.O
Auth.OAuthUserDetailsServicelmpl">
<property hame="state">
<value>WA</value>

</property>

</bean=>

Jaspersoft Roles

<bean
id="mtExternalUserSetupProce
ssor"
class="com.jaspersoft.jaspers
erver.multipleTenancy.security
.externalAuth.processors.MTEXx
ternalUserSetupProcessor"
parent="abstractExternalProce
ssor''=

<property
name="organizationRoleMap"
>

<map>

<!I-- Example of mapping
customer roles to JRS roles --
>

<entry>

<key=>
<value>ROLE_ADMIN_EXTER
NAL_ORGANIZATION</value>
</key>

<value>ROLE_ADMINISTRATO
R</value>
</entry>

</map>

All the Jaspersoft Roles are configured
inside this tag. If any new Jaspersoft
Roles are needed, they must be
configured here. In the <entry> tag, the
key value should match with the client
role defined at the Keycloak end.

Currently, the following roles are
configured:

1. Administrator
2. Superuser

3. User Role

2. Copy the applicationContext-externalAuth-oAuth.xml file (edited in Step 1)
to <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB- INF.

3. Copy stc-jaspersoft-oauth-1.0.0.jar (available in the JRS distribution folder) to
<JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/1ib.

4. Create and save a backup of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-

security.xml file.

5. In <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-
INF/applicationContext-security.xml, replace the access value for the

method
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com. jaspersoft. jasperserver.api.metadata.user.service.ProfileAttribut
eService.putProfileAttribute with ROLE _USER.

6. Save a backup copy of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-

security.xml file again and replace the constructor-arg value for
org.springframework.security.web.authentication.LoginUrlAuthenticationEntryPoin
t with Zoauth.

7. Add the SSL certificate used by Keycloak to the Java installation that Jaspersoft is
using. (By default, Java only knows about a small number of root certificates.) To
do this, follow these steps:

a. Copy InstallCert$SavingTrustManager.class and InstallCert.class
(both available in the STC Suite Distribution/Server Components/JRS
directory) to the <JASPERSERVER_DIR>/java/bin directory.

b. NOTE for sso-dev.stchome.com: This is only for Dev SSO SSL certificate
installation. This URL changes based on your server hostname of the
Keycloak/SSO server.

c. Go to the <JASPERSERVER_DIR>/java/bin directory and execute these
commands. The [sso_link] differs based on the environment; an example
might be something like sso-dev.stchome.com.

jJava -cp -\ InstallCert [sso_link]

keytool -exportcert -alias [sso_link]-1 -keystore jssecacerts -
storepass changeit -file [sso_link].cer

keytool -importcert -alias [sso_link] -keystore
../lib/security/cacerts -storepass changeit -file [sso_link].cer

8. Make database changes with the following commands. Jaspersoft stores all of its
metadata in the Postgres database. All of the user-based profile attributes are
stored in the jiprofileattribute table in Jaspersoft. By default, user attributes
support a character size of 200. In Step E below, the data type size is changed
from 200 to 1,000.

Navigate to the <Jasper Installation Directory>/postgres directory.
a. Run this command: psql -U postgres -W (the password is postgres).
b. Now you should see at the prompt: postgres=#

c. Enter this command to connect to the Jasperserver database in Postgres: \c
Jasperserver; (the password is postgres).

d. Execute this SQL alter script: ALTER TABLE jiprofileattribute ALTER
COLUMN attrvalue TYPE character varying(100000);

9. Restart the Jasper server and navigate to JasperUrl/oauth (see example). You

should now be redirected to Keycloak to log in. Example:
http://52.10.228.158:8080/jasperserver-pro/oauth
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Steps to Debug Issues Related to
Keycloak/JasperReports Server Integration

If there are any issues with integrating Keycloak with Jasper, follow these suggestions
below.

Check the applicationContext-externalAuth-oAuth.xml File

Make sure that applicationContext-externalAuth-oAuth.xml is configured with the
correct Keycloak and Jasper server parameters and with the correct client_secret.

Keycloak Mappers
Make sure that the Jasper client has the below mappers mapped correctly in Keycloak,

and check if the Org/fac List mapper contains the correct parameters. (Note that your
API-KEY and API-URI will differ from the image below.

Org/fac List

Protocol

Name

Consent Required OFF
Mapper Type
Token Claim Name org-fac

PI-KEY

API-URI

Response format application/json ¥

m Cancel

Name Category Type

org/fac list Token mapper Org/fac list

email Token mapper User Property
groups Token mapper Group Membership
username Token mapper User Property
realm roles Token mapper Realm Role List
roles Token mapper Client Role List
given name Token mapper User Property
family name Token mapper User Property

full name Token mapper User's full name
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Validate the IWeb Web Service

Make sure that the IWeb web service URL is accessible. The output of this should
return the org/fac list. If there is an error, it needs to be fixed.

3 hetprhD o0 8 L Frnee T

Check the Whitelist Rules

If Jaspersoft is installed in an AWS environment, the outbound connection on port
8080 should be enabled for the IWeb server.

If Keycloak is installed in an AWS environment, the outbound connection on port 8080
should also be enabled for the IWeb server.

Check the Firewall Rules

If there are any special firewall rules preventing the Jasper and/or Keycloak servers
from accessing IWeb through port 8080, the need to be fixed so that the port is
enabled.

JasperReports Server Upgrade - Windows

These instructions are only required when deploying SMaRT AFIX for the first time or
when upgrading from a version of SMaRT AFIX older than 1.17.4. If you have already
deployed SMaRT AFIX 1.17.4, you should already have the web service plugin installed
on your JasperReports server and can skip these instructions.

As a part of SMaRT AFIX 1.17.4, the new SMaRT AFIX Online Tool web service was
introduced to help support the CDC's AFIX Online Tool application. In order to integrate
this tool with SMaRT AFIX, a plugin must be added to the existing JasperReports server.

Prerequisites

1. JasperReports server has been installed.

2. The web service plugin zip file has been downloaded to your application server
(APP) and the contents extracted. The unzipped folder is referenced as $WS_DS
from this point on.

\APP\JRS\webserviceds_v1.0_3.zip

3. Locate your JasperReports server web application folder, which is referred to as
$IJRS_HOME from this point on. It is recommended that you back up this folder
before beginning the plugin installation.
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C:\Jaspersoft\jasperreports-server-6.2\apache-
tomcat\webapps\jasperserver-pro\

Plugin Installation Steps

The installation should be performed as root user.

1.
2.

3.

Stop your web server running JasperReports server.

Open the folder $WS_DS/JRS/WEB-INF/bundles and copy the contents to

$IRS_HOME/WEB-INF/bundles/. Note that this should not overwrite any existing

files.

Restart the JasperReports server.

Validation Steps

Follow these steps to confirm that the plugin has been successfully installed:

1.
2.

Navigate to your JasperReports server admin console.

Log in as an admin-level user.

TIBCS Jaspersoft’ #& by View. #anage.

Home

» Recently Viewed Items Data Sources
on to 3

database or other dat

v Popular Resources

Select Create = Data Source from the top menu.

L-‘ MY{H i 'w { E stchome [ afix_reporting X yg TIBCO Jaspersoft: Home X _I

< C 1 | ® 52.37.156.46:8080/jasperserver-pro/flow.htm|?_flowld =homeFlow
E:' Apps Google Apps STC Links IWeb Git Timesheets CR145 Citrix Ja
T|BC@IJaSperSOft' #& Library View+ Manage~ Create~
Home Ad Hoc View
Report
» Recently Viewed Items Dashboard S
CoverageRateReport_Adolescent Report Domain OI””E
CoverageRateReport_Childhood Report

Create Vi
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4. Confirm that Web Service Data Source is listed in the Type drop-down list.

L' ™M Y n -_\ i { Q stchome / afix_reporting X yg TIBCO Jaspersoft: New [ X _

&« C Y | ® Mot secure | 52.37.156.46:8080/jasperserver-pro/flow.htm|?_flowld =addDataSourceFlow&ParentH

55 Apps Google Apps STC Links IWeb Git Timesheets CR145 Citrix JasperSoft KeyCloak

TIBCQ'Jaspersoft' #& Library View. Manage~ Create~

New Data Source

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: Web Service Data Source v
AWS Data Source

Bean Data Source

Cassandra Data Source

Internal Diagnostic Data Source
none |JDBC Data Source

JNDI Data Source

MongoDB Data Source

Langua MongoDB IDBC Data Source

json Virtual Data Source

Web Service Data Source

Request Verb:

Auth Ty

post

Web Service URI:

SUpEruser

Password:

Username:

VOMS JasperReports Deployment -
Windows

The following outlines how to import (migrate) Jaspersoft Reports for VOMS.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured

o Retrieve the passwords for the SMaRT AFIX database (afixdb)

e Retrieve the Jaspersoft superuser username and password

e Confirm that the SMaRT AFIX Online Tool web service is installed

e Confirm that all necessary ports are open across all firewalls (the default port is
80)

e Confirm that the release distribution zip file for Jasper Reports is extracted from
/APP/JIRS/AFIX_Reports-[version number].zip and copied to your local drive.
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e Important: Be sure to update the JasperReports server by following the
instructions in SMaRT AFIX JasperReports Server Upgrade - Windows.

Procedure Steps

Follow these steps to deploy Jaspersoft Reports.

Export the Jaspersoft Repository for Backup

Export the repository by selecting Manage > Server Settings > Export (Export
Everything) in Jaspersoft. Save the file as a backup.

| TIBC® Jaspersoft” # by View- Manage- Creste-

i Sertings Export

File Properties
vata File Name (required)

export.zip

Fxport Oplions:
& Export Everythinc

Roles and Users to Export

Roles:

Resources to Fxport Assets to Fxport Events to Fxport

Import the Content via the Portal

1. Log in to the Jaspersoft Bl Portal as the administrator user.
2. Navigate to Server Settings > Import.

3. Import the AFIX_Reports-[version number].zip file.

4. Update the data source with the database connection information.

Import the Content via the Command Line

1. Confirm that JAVA_HOME is set and your path includes jre\bin or jdk\bin.

2. Change to the buildomatic directory on the JasperReports server:

C:\Jaspersoft\jasperreports-server-6.2.1\buildomatic
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3. Execute the migrate command (adding in the correct version number): js-

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide

import_bat --input-zip "AFIX_Reports-[version number].zip" --update -
-skip-user-update --include-access-events --include-audit-events --
include-monitoring-events

Update the data source with the database connection information: From the left
menu, go to root > AFIX = Data Sources. Select AFIX_AWS, then click the
Edit tab. Specify your database connection properties for Host, Port, and
Password, then click Save.

TlBC"Jaspersoft- # Library Views Manage+ Create«

£ Folders Repository
(Sl root Run Edit | Open Copy  Cut Paste | Delete
£ AFIX ¢ Name Description

{5l Adhoc Views

ffal Bundles LR LG
{ful Dashboards

{flul Domains

fal Images

{fal Input Controls

(5l Queries

[Eg. i Reports

Select AFIX_EXPORT, then click the Edit tab. This is the web service data source
linked to the SMaRT AFIX Online Tool web service.

T[BC"JaSpersoft' #A& Library Views Manage- Create~

£ Folders Repository
[l root Run Edit Open  Copy  Cut Paste | Delete
Sl AFIX o
Name Description

@l Adhoc Views

@l Bundles AFIX_AWS
(Bl Dashboards AFIX_EXPORT

&M Data Sources

t:l_, Domains

\:1 « Images

5™ Input Controls
\:L, Queries

[l Reports

Leave the defaults for Auth Type, Language, and Request Verb. Update the web
service URI to point to your SMaRT AFIX Online Tool web service deployment.
Note that even though the Password field is populated, no password is present or
required; leave it as it is. Click Save when finished.
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Edit Data Source: AFIX_EXPORT

Set Data Source Type and Properties

Type:

Auth Type

none

Request Verb:

get

Web Service URI

http://10.0.0.12:8080/afix. export ws/

Usarname:

m S

First, select the type of data source you wish to add, then enter the required property values.

Validate the New Content

The following steps perform a spot check on the newly created content to validate it and
to check for any serious errors. It does not perform a full check of all possible issues and

should be followed up with a functional validation of the content.

1. Log on to the Jaspersoft Bl server as a user able to run a report. The user should
be able to log in successfully and see the subfolders under /root/AFIX (select

View > Repositories).

Sl root

Tl Adhoc Views
Bundles
Dashboards
Data Sources
Domains
Images

Input Controls

Queries

N EEEE B EEE

Reports

2. Validate that the user can execute and view a report as defined by their class or

organization membership: Select the report from
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AFIX/Reports/AFIX_Online_Tool, select one report from any of the other sub-
directories of AFIX/Reports, and confirm that both reports execute successfully.

Restore the Previous Content (if Necessary)

If there are any uncorrectable issues and the release upgrade needs to be aborted, follow
these steps to revert to the previous content:

1. Using the backup exported at the beginning of these steps, import using the steps
above. Note that a re-import of the previous version of the content will also
achieve the same back-out.

2. Perform the validation steps listed above.

Node.js Installation - Windows

Node.js installation is not supported in Windows.

SMaRT AFIX Application Installation
Instructions - Windows

The following instructions explain how to install the application, the Oracle Instant Client,
Visual Studio 2013 Community Edition, Windows SDK v8.1, and Redis; how to configure
the application dashboard and quick links; specific configuration options, and information
on standalone versus multiple application deployment.

If you are upgrading from a previously installed version of SMaRT AFIX, you can skip
directly to the Install the Deployment Package section and continue from there.

Prerequisites

The following should already be installed and configured:

e Windows Server 2012

e PostgreSQL server (DBB)
e Oracle server (COR)

e Node.js (APP)

e PM2 (APP)
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Installation and Deployment of SMaRT AFIX, iQ, and
VOMS

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, you only
need to install the Oracle Instant Client, Visual Studio, Windows SDK, and Redis with the
first application installation. Once these are installed, for subsequent applications that
are running on the same server, you can skip down to the Install the Deployment
Package section and continue from there instead.

Install the Oracle Instant Client

1. Download Oracle Instant Client Basic and SDK for Windows. Extract Instant Client
Basic somewhere on the disk (i.e., C:\oracle\instantclient_12 1), then
extract Instant Client SDK into the same folder.

2. Add the path you extracted Oracle Instant Client into to the PATH environment
variable. This can be accessed via the Advanced System Settings window.

3. Add the following system variables. (See https://github.com/oracle/node-
oracledb/blob/master/INSTALL.md#instwin and
https://community.oracle.com/docs/DOC-931127 for more information.)

e OCI _LIB DIR to C:\oracle\instantclient_12 1\sdk\lib\msvc

e OCI_INC _DIR to C:\oracle\instantclient_12 1\sdk\include

Install Visual Studio 2013 Community Edition

See https://www.visualstudio.com/en-us/news/releasenotes/vs2013-community-vs for
download and installation instructions.

Install Windows SDK v8.1

See https://developer.microsoft.com/en-us/windows/downloads/windows-8-1-sdk for
download and installation instructions.

Install Redis
Use this command:

msiexec /i Redis-x64-3.2.100.msi

See https://github.com/MicrosoftArchive/redis and
https://github.com/MicrosoftArchive/redis/releases/tag/win-3.2.100 for more
information.
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Install the Deployment Package

Copy the provided zip/tar file to the target server. Extract the archive and change into
the parent of the directory where it was extracted.

Configure the Application Dashboard and Quick Links

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, the steps
below only need to be completed the first time an application is installed. This file should
be saved for all subsequent installations.

1. Download the apps.json file from the release distribution application components
shared folder.

2. Edit this file with a text editor and replace the placeholders DASHBOARD_ URL,
IWEB_URL, AFIX_URL, PHC-HUB_URL, 1Q_URL, and VOMS_URL (if applicable for
your installation) with their respective URLs.

3. Save this file and keep it handy as you will need to use it in the installation of iQ,
VOMS, and the SSO dashboard.

An example of one such configuration object in the JSON file is shown below. In most
cases, only the URL value needs to change:

{
"icon': "/static/public/img/STC - SmartAFIX.svg",

"id": "AFIXT,

“name': "'SMaRT AFIX",

“url™: “https://afix.stchome.com *,

"description': "Utilized to make AFIX assessments efficient, standardized and
meaningful .*,

"hidelfUnavailable': true,

"accessRole": "Access_afix"

}

Copy this file to the following location:

<application_install_dir>/src/shared/helpers/appActions/

Configure the Reverse Proxy

A reverse proxy is recommended to provide access to the various products. This is not
explicitly required unless the products are running with the ENABLE_SSL option set to
true. However, this will generally be the case when the products are being run in
conjunction with IWeb on the same server. See the example Apache configurations at
package/docs/apache.

General Product Configuration Options

Once the package containing the products has been installed, there are some
configuration options that can be set depending on the environment. The majority of
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these lie in package/process. json, which is simply a JSON configuration file for pm2.
The options listed in bold below need to be changed to match your environment. Other
options not in bold might not need to change, and in most cases can be the default
setting. Some options in the process. json file are not listed at all below; those options
should be left unchanged.

The options are as follows:

Option ‘Description

script Location of the startup script application. The path to the script
may need to be customized.

cwd The path to the application. May need to be customized.

PRODUCT The name of the product.

HOST The host name for the product.

APIHOST The host name of the product's respective API server (generally
localhost).

PORT The port for the product.

APIPORT The port for the product's APl server.

NODE_ENV This should always be production.

SAML_ISSUER

The SAML issuer (client) from Keycloak.

SAML_ENTRY_POINT

The SAML entry point from Keycloak.

JASPER_SERVER

The domain name of the JasperReports server.

REDIS_URL

The Redis URL used for storing client sessions.

REVERSE_PROXY

When configuring SMaRT AFIX with a reverse proxy, this should be
set to true.

ENABLE_SSL

When set to true, this enables HTTPS support. If REVERSE_PROXY
is set to true, this should be set to false even when the
environment is configured for HTTPS.

SECRET_SESSION

The secret key for session storage. IMPORTANT NOTE: This value
must be exactly the same for every application, in both the server
and the API environment variables.

SMaRT AFIX-Specific Configuration Options

The following options are specific to SMaRT AFIX configuration settings:

VOMS_ORACLE_USER

Description

The username for IWeb's SIIS database. This is set to the
default user for the SIIS, but may need to be updated
depending on your configuration.
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Option Description

VOMS_ORACLE_PASSWORD

The password for IWeb's SIIS database. This is set to the
default password for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_CONNECTION

Connection information for IWeb's SIIS database. This needs
to be updated to point to your IWeb's Oracle database
instance.

PG_USER

The user account for the SMaRT AFIX PostgreSQL database.

PG_PASSWORD

The password for the associated PG_USER for the SMaRT AFIX
PostgreSQL database.

PG_HOST

The hostname for the SMaRT AFIX PostgreSQL database.

PG_PORT

The port number for the SMaRT AFIX PostgreSQL database.

AFIX_EXPORT_URI

The URL for the SMaRT AFIX Online Tool web service. Only the
hostname and possibly the port number for the URL need to be
updated.

AFIX_EXPORT_KEY

The API Key for the SMaRT AFIX Online Tool web service. This
should be left as the default.

CDSI_FORECASTER_VERSION

The current version of the CDSI Forecaster deployed. For the
SMaRT AFIX 1.17.5.4 release, it should be set to 5.17.10.

SMaRT AFIX for Independent Partners-Specific Options

These options are used for independent builds of SMaRT AFIX (i.e., not connected to
IWeb) only and should be left unchanged for builds involving 1Web.

Option Description

APIl_URL_PREFIX This sets the API prefix for independent mappers.

MANAGE_URL_PREFIX This sets the Manage Users page URL.

IS_INDEPENDENT When this option is set to true, it enables independent build
functions.

MANAGE_USER_EMAIL This enables the password reset functionality for the Manage Users
page.

SERVICE_API This enables custom report template sharing for independent
SMaRT AFIX. It should be set to api/orgFacSearch.

Run the Application

Use pm2 to run the deployment package as shown below. In many cases, environment-
specific configuration options must be set prior to running an application's package. See
the configuration option sections above for more details.

pm2 start package-parent/process.json

SMaRT AFIX 1.17.5.4 for Independent Partners Installation Guide

Page 101



Start the Products upon Bootup

To have the products automatically start on every boot, do the following once it has been
verified that they are running correctly:

npm install -g pm2-windows-service
pm2-service-install [-n service-name]
pm2 save
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Keycloak Configuration for SMaRT AFIX

This task is to be performed during SSO installation of the application. The table below
lists each application and component, along with the JSON file name, client name, and
URL placeholder name for each. Make sure to use the correct file and other information
corresponding to the specific application/component installation.

Application Name JSON File Name Client Name URL Placeholder Name

IWeb iweb.json iweb IWEB-URL
PHC-Hub phchub.json phc-hub PHC-HUB-URL
Jasper Report Server |jasper.json jasper JASPER-URL

iQ interop.json interop INTEROP-URL
VOMS voms.json voms VOMS-URL
Logviewer interop-logviewer.json [interop-logviewer |[LOGVIEWER-URL
Dashboard dashboard.json dashboard DASHBOARD-URL

Import the Client and Roles

These steps explain how to import the client and configure the roles.

Prerequisites

The location of the JSON file for the application being installed.

Import Steps

1. Log in to Keycloak.

2. Select the desired realm for the application suite in the top left drop-down list.
3. Click Import on the left side menu.
4

Click the Select File button and browse to the SMaRT AFIX release /SS0/JSON
directory.

5. Select the aFix. json file and click Open.

6. Important: In the If a resource exists drop-down list, select Skip.

Configure the Client

1. On the left side menu, click Clients.
2. Locate the client named afix you just imported (see above) and click Edit.

3. On the Settings tab, enter the URL to the application everywhere there is a URL
placeholder.
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4. If the Client Protocol is SAML, expand the Fine Grain SAML Endpoint Configuration
section at the bottom of the page and make sure the URL placeholders are
replaced with the application URL.

Click the Save button at the bottom.
Click on the Mappers tab.

Locate the user-type mapper and click the Edit button.

® N o o

In the API-URI box, replace the URL placeholder with the URL to your 1Web
installation.

9. Verify the API-KEY is set to the APl key of your IWeb instance.

10. Click the Save button at the bottom.

Additional User Role for Independent Partners

The SMaRT AFIX build for Independent Partners requires an additional realm role called
ManageUsers. Follow these instructions to add it:

On the left side menu, click Roles.
On the Realm Roles tab, click the Add Role button on the right.
In the Role Name box, enter ManageUsers.

1
2
3
4. For Description, select to allow Access Manage Users Page.
5. Click the Save button at the bottom.

6

Confirm that ManageUsers now appears in the Roles drop-down list.

Configure the Management Users in Keycloak

For Independent Partners, a few management users must be configured in Keycloak.
Once these users are set up, they can enable all other users on the Manage Users Page
in SMaRT AFIX. The following steps can be performed only after the ETL jobs have
completed and the users have been successfully migrated to Keycloak.

1. In Keycloak, click Users in the left side menu.

2. Either search for a management user by name in the Search box (click the
magnifying glass icon to search) or click View all users and click on one of the
users in the list.
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{MAKEYCLO

AFIX-IND Users

Q | View all users
Realm Settings

Clients

Client Templates

Roles

Identity Providers

User Federation

Authentication

Users

Sessions

3. After selecting a user, the Users page refreshes with the selected user's
information. Click the Role Mappings tab. Notice that the user has two roles
assigned: offline_access and State.

4. From the Available Roles, select access_afix and ManageUsers, then click Add
Selected to apply the roles to the user.
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5. Click the Credentials tab and update the user's password. You can set a default
password if you want to, but whether you do or not, make sure to select Update
Password in the Reset Actions drop-down list and then click Send Email. This
sends an email to the user with a link to reset their own password.

6. Repeat this process for every user that needs to have Manage Users access.
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